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Welcome to ARC+ Render Pro 
The ARC+ Render Pro application provides a complete rendering environment 
for architects, interior and exterior designers, landscape architects and 
furnishings designers.  Using ARC+ Render Pro, you can produce photo-realistic 
images containing the colors, textures and transparencies of the planned 
materials that fit seamlessly into a photograph of the construction site.  ARC+ 
Render Pro offers animation modules: the walk-through animation and the 
lighting animation.  These modules enhance your 3D scenes with walk-through 
tours of rooms, down corridors and have special lighting effects to highlight 
buildings, interior design and much more.  
  

 
Design by Mor Architects, rendering by Magoz Point Imaging 
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Overview of this Manual 
 

1 Getting Started Installing the ARC+ Render Pro software 
Working in the ARC+ Render Pro screens and commands 
 

2 Attributes Setting the colors, materials, and textures of objects  
Smoothing the surfaces of objects 
Using billboards to automatically rotate objects towards camera 
 

3 Cameras Setting the projection of the rendered image 
 

4 Lighting Creating colored and multisource lighting schemes 
Using point, spot, and distant light sources 
Using ambient light, background, and fog 
 

5 Rendering Producing photo-realistic rendered and ray-traced images 
Controlling the image type and quality 
Viewing rendered images 
 

6 Walk-through 
Animation 

Producing walk-through animated view of rendered scenes 
 

7 Lighting Animation Producing animated lighting view of rendered scenes 
 

8 Panorama Producing panoramic view of rendered scenes 
 

9 Objects Animation Producing objects animation 
 

10 Photo-realistic Objects Inserting photo-realistic objects 
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About this Book 
The ARC+ Render Pro User's Guide describes the optional ARC+ Render Pro 
module of ARC+. The book contains complete instructions for installing and 
using ARC+ Render Pro. 

Before you read this book, you should have a basic familiarity with ARC+. If you 
are a new ARC+ user, you should read the chapters Getting Started and Basic 
Tools in the ARC+ User's Guide. 

Using ARC+ Commands 

You can access the ARC+ Render Pro commands from the ARC+ Render Pro 
menu or by typing the command name. To display the ARC+ Render Pro menu, 
choose the ARC+ Render Pro option on the Tools menu of ARC+. To return to 
the regular ARC+ menu, choose ARC+ from the Tools menu. 

This book presents the commands in the same format as other ARC+ 
documentation. For a complete explanation, see the Preface of the ARC+ User's 
Guide. 

For example, to start the command for Defining the Location and Type of Lights. 
You can start the command in either of two ways: 

� Using the ARC+ Render Pro menu: choose LIGHTS and then GRAPHIC EDITING. 
� Using the keyboard: type \grlight on the ARC+ command line. 
 
These possibilities are illustrated in the following standard format throughout 
this book: 
 

\grlight Lights
Graphic Editing

ARC+ Render menuKeyboard command

  
 
Many of the ARC+ Render Pro commands operate in a special rendering mode, 
where the ARC+ command line is not displayed. While you are in the rendering 
mode, start each command from the menu alone. 

In the rendering mode, there are many operations that you can perform using 
icons, toolbars, or popup menus. These options are explained in the relevant 
sections throughout this book. 
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Terminology 

Throughout this manual the terms 'model' and 'scene' are used interchangeably.  
Both terms refer to the visual environment created with 3D objects, textures, 
materials and colors. 

Cross References 

Commands that are referenced are italicized, with the chapter number and name 
first, and the keyboard command name in parentheses. For example: 

See Chapter 4, Lighting, Defining the Location and Type of Lights (\grlight). 

Color Images 

Some versions of this book contains grayscale images explaining how to use 
various features of the software. The images are displayed in color on the ARC+ 
Render Pro screen.  

The illustrations of the screen and dialog boxes are not intended to be exact 
representations of any one computer. Depending on your computer system and 
the software release, the appearance may vary slightly from the illustrations in 
the book. 

Additional Resources 

The following resources help you get information on Graffiti products: 

� ARC+ Render Pro Web site: http://www.arcrender.com 
� ARC+ Render Pro documentation suggestions, errors, or questions: send 

email to docs@arcrender.com 
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This chapter provides a thorough overview of the ARC+ Render Pro application 
and operating instructions.  

With ARC+ Render Pro, you can add to your model: 

� Lighting and shadows, including multi-source and colored lighting schemes 
� Realistic colors and textures for materials and background 
� Transparent, reflective, shiny or dull surfaces 
� Smoothing of curved surfaces 
� Atmospheric conditions such as sky and fog 
� Photo-realistic objects 

You can select the ARC+ Render Pro commands from the pull-down menus at 
the top of your ARC+ screen, without leaving the ARC+ system. 

Version Information 
This book describes ARC+ Render Pro version 9, compatible with ARC+ version 
13, 14, Progress or above. 

Version information can be found under HELP > ABOUT. 

 IMPORTANT   If you edit a model using ARC+ Render Pro 9, do not attempt to open 
it in earlier version of ARC+ Render Pro. If you attempt to do so, the rendering files 
(*.GRB and *.GRT) may be damaged. 

Installing ARC+ Render Pro 
In order to install and run ARC+ Render Pro: 

1
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� You must have a hardware (Hasp or NetHasp) lock with ARC+ Render Pro 
permission attached to your parallel port. 

� Your display monitor must be set to at least 800 x 600 resolution and 256 or 
more colors. 

If you don’t have the stand-alone version of ARC+ Render Pro, you must have 
ARC+ installed on your system. 

Other system requirements are the same as for ARC+. For details, see the Getting 
started chapter in the ARC+ User's Guide. 

 NOTE   If your hardware lock is not currently valid for ARC+ Render Pro, you can still 
install ARC+ Render Pro but you can't run the program. You are prompted to enter key 
codes when you enter ARC+ Render Pro following the installation. See Updating HASP 
Key Codes. 

Upgrading from a Previous Version of ARC+ Render  
Before you upgrade, make a backup copy of any new textures that you added to 
ARC+ Render and any models or rendered images that you saved in the ARC+ 
Render directory. Save the backup in another directory location.  

If you want to keep files in the old ARC+ Render directory, you can install the 
new version in a different directory. However, you cannot run the old version of 
the ARC+ Render program after you install the new version. 

Installing ARC+ Render Pro from CD-ROM 
1. Insert the ARC+ Render Pro CD-ROM in your computer. The setup program 

starts automatically. 

 NOTE   Alternatively, you can start the SETUP.EXE program by double-clicking in the 
Windows Explorer. The program is located in the RENDER\DISK1 directory for your 
language on the CD-ROM (for example, D:\ENGLISH\RENDER\DISK1\SETUP.EXE). 
Consult the redame file on the CD-ROM for latest information. 

2. Select the language you want to install (English, French, Spanish, etc.). 

3. Click the button to install ARC+ Render Pro. 

4. Confirm the destination directory where ARC+ Render Pro is installed (by 
default C:\PROGRAM FILES\ARC RENDER), or click BROWSE to specify a 
different directory. 

5. Confirm the folder name for ARC+ Render Pro on your Start menu (by 
default ARC+ RENDER PRO V9.0), or specify another name. 

6. When the installation is complete, reboot your computer for the changes to 
take effect. 
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Installing ARC+ Render Pro from a Network Location 
1. Connect to the network location where the administrator's version of ARC+ 

Render Pro is located. 

2. In the Windows Explorer, double click the RENDER\DISK1\SETUP.EXE 
program. 

3. Confirm the destination directory where ARC+ Render Pro is installed (by 
default C:\PROGRAM FILES\ARC RENDER), or click Browse to specify a different 
directory. 

4. Confirm the folder name for ARC+ Render Pro on your Start menu (by 
default ARC+ RENDER PRO V9.0), or specify another name. 

5. When the installation is complete, reboot your computer for the changes to 
take effect. 

Updating HASP Key Codes and User Information 
Make sure your hasp is connected, then start ARC+ Render Pro.  Select HELP > 
USER INFORMATION to open the USER INFORMATION dialog box. 

 
 

Key in the three key codes provided by your dealer (or four key codes for 
NetHasp). 

Key in your HASP S/N code printed on a sticker on your HASP. 

Click Update and then OK. 
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Click View to display the HASP information in Notepad. 

 
Contact your dealer should you view any error messages.  Current users should 
contact their dealer for update and key code information. 

If no version of ARC+ Render Pro is installed on your computer and the HASP 
plug isn’t key coded, the program will automatically launch the window for 
updating the key codes, similar to the above window. 

Click SUPPORT to submit HASP information on the web. 

Read the ARC+ Render Pro Readme File 
Complementary or updated information about ARC+ Render Pro that was not 
available when this book was printed may be included in a README file on the  
CD-ROM. Read this file before you start working. 

Setting the Windows Display Properties 
ARC+ Render Pro can produce rendered images with many different file formats 
and color qualities. The highest quality uses 24 computer bits (0's and 1's) to 
represent each color, and is known by the names 24-bit color, true color, and RGB 
color. An image produced with 24-bit color can contain up to 16.7 million shades 
of color.  

You can use ARC+ Render Pro to produce a 24-bit image file, even if your 
computer is not set for a 24-bit display. If your computer is set to the Windows 
default of 256 colors (8-bit color), you may notice dots, lines, or patches in the 
color when you display the image on the screen. The faults are purely a display 
phenomenon. The file actually contains a smooth gradient of colors, and if you 
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reset your computer to 24-bit color, the same file displays as an accurate color 
image. 

To set your computer to a 24-bit color display: 

1. Click the right mouse button on an empty area of the Windows desktop. 

2. From the popup menu, select PROPERTIES. 

3. Select the SETTINGS tab. 

4. Select one of the True Color options, for example TRUE COLOR (24 bit). 

5. Click OK and if prompted, reboot your computer. 

 NOTE   The exact instructions may vary depending on your hardware type. If your 
hardware and resolution settings do not support true color, high color (16 bit) is also a 
good choice. 

Preparing an ARC+ Model for Rendering 
Before you can render a model, you must create it or display it on the ARC+ 
screen. You may create it with any of the standard ARC+ three-dimensional 
building blocks:  

� Polygons 
� Simple solids (prisms) 
� Complex solids 
� Walls 
� Placed objects containing any of the above entity types 

ARC+ Render Pro displays these entities with true colors, textures, lighting, etc. 
in the final rendered image. 

You may also include other types of entities in your model-lines, text, 
dimensions, help lines, hatching, and patterns. These entities are ignored by 
ARC+ Render Pro commands, however, and they are omitted from the final 
rendered image. 

 NOTE  You cannot render a two-dimensional projection of an ARC+ model created, for 
example, with the Saving a 2D projection of a model (\save2d) command (see Files 
in the ARC+ User's Guide). You can render a model that you imported from another 
program, e.g., as a DXF file, provided the model contains polygon and/or solid entities. 
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Placed Objects 
You may include placed objects in your model file. The component entities of a 
placed object are rendered in exactly the same way as other entities in your 
model.  

ARC+ Render Pro modifies the source (library) file of the placed object slightly. 
It does this by storing the rendering attributes that you assign to entities in the 
placed object in the source file (see Model and rendering files). This may have 
undesirable consequences if you render another model containing the same 
placed object. 

For example, create a model using a library coffee table as a placed object. If you 
give the tabletop a mirror material attribute, this information is stored in the 
library file. Unless you afterwards cancel the attribute, the table will have the 
same mirror finish when you render any other model that uses the same library 
file. 

To prevent this, copy the library file to your working directory and place the 
copy in your model. Then, only the copy file is modified; the original library file 
remains unchanged. 

 NOTE   Optionally, you can tell ARC+ Render Pro to copy the library files when you 
apply the attributes. See Model and rendering files for more information. 

Openings (Negative Solids) 
ARC+ uses negative solids to represent openings or voids in other entities, for 
example doorways or windows in walls (see Polygons and solids and Openings in 
the ARC+ User's Guide). You may include negative solids in your model: they are 
rendered as transparent areas, as you would expect.  

If you wish to display a surface within an opening, for example a wooden door 
or reflections off a glass windowpane, then draw an ordinary, positive solid 
within the opening. 

ARC+ Colors and Rendering Attributes 
You can render a model using the following color options: 

� You can use the standard ARC+ palette of fifteen colors and the internal 
ARC+ rendering attributes (color, texture, and transparency, see Rendering in 
the ARC+ User's Guide). To do this, prepare the model with the desired colors 
and attributes for each entity. 

� You can obtain much better results by assigning colors and other attributes 
such as materials and textures in ARC+ Render. ARC+ Render allows you to 
assign over 16 million different rendering colors to your entities. The colors 
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and attributes that you assign in ARC+ Render override the standard ARC+ 
colors and the internal ARC+ rendering attributes. 

� You can color-code the entities in your model with the standard ARC+ colors 
1-15. For example, use color 1 for concrete, color 2 for wood, color 3 for glass, 
etc. During the rendering process you can construct a color mapping table that 
translates the standard ARC+ colors into combinations of ARC+ Render Pro 
colors, materials, and/or textures. 

� You can combine these methods in a single rendering. For example, you can: 
� Render some entities in your model with their standard ARC+ colors and 

attributes 
� Assign special rendering colors and attributes to other entities 
� Color-code still other entities and render them with the color mapping 

table 
See Chapter 2, Attributes, for full information on the treatment of colors and other 
attributes in rendering. 

Displaying the Model 
Before you render the model, display it on the ARC+ screen in the modeling 
mode. You may display the model in any convenient view-plan, elevation, 
axonometric, parallel, or perspective.  

Starting ARC+ Render Pro 
To start ARC+ Render Pro (if you don’t have the stand-alone version), enter 
ARC+. On the Tools menu, select the ARC+ Render Pro option. 
 
 
 
 

Tools 
ARC+ Render Pro 
 

 
To return to the ARC+ menu, select ARC+ on the Tools menu.  
 
 
 
 

Tools 
ARC+ 
 

 
 NOTE   There is also a stand-alone version of ARC+ Render Pro, which you can enter 

without going through ARC+. For further information about upgrade, please contact 
your ARC+ Render dealer or ARC+ Render web site (www.arcrender.com). 

 

To start ARC+ Render Pro stand-alone version, you can use Windows Start 
menu, or start through ARC+. 
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Entering ARC+ Render Pro Commands 
The ARC+ Render Pro menu replaces the ARC+ menu in the display. You may 
select ARC+ Render Pro commands from the menu, or type the command names 
beginning with a backslash (like any other ARC+ commands) on the input line. 
Upon starting ARC+ Render Pro, the menu bar is displayed. 
 

  
 NOTE  Open and save file operations are available in the FILE menu of ARC+ Render 

Pro when running as stand-alone. When working under ARC+, Use FILE from the 
regular ARC+ menu to open and save files. 

The ARC+ Render Pro Screen 

The ARC+ Render Pro main screen. 
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This screen contains a menu bar, Windows-standard tool bar, a viewing toolbar 
and a draw toolbar. The central part of the screen contains three work windows, 
showing different views of the model, and the scene tree view window (shown 
above - lower left). On the right side are the materials and textures toolbars.  The 
bottom part of the screen contains the colors toolbar and the status bar.  Like any 
Windows-standard screen, all components can be customized. 

The Menu Bar 

The menu bar is displayed on the top of the screen, under the program name 
and displayed file name. 

Menu Options 
The function of each command is described below: 

FILE General file level operations. When working under 
ARC+, you can: save bitmap, pack/unpack model, 
import textures, print files. When working in stand-
alone mode, you can also: open and close an existing 
file, save files. 

EDIT File editing utilities: undo/redo, cut, copy, paste, 
delete, attach options, view log file, view properties 
of the selected object. 

VIEW Configure the appearance of the selected work 
window: WireFrame, Hidden Lines, Shaded, No 
Shading, Dynamic Rendering, Ray Tracing. It also 
enables refreshing the display and controlling the 
view options. Note that some of the view options can 
also be controlled from the draw toolbar. 

ATTRIBUTES Control the display in the scene tree window: all 
objects are displayed (dynamic editing), or only 
specific objects (color mapping, layer mapping, lights, 
cameras, clipboard). 

CAMERAS Control the viewpoints (cameras) of the rendered 
model. See Chapter 3, Cameras. 

LIGHTS Control the lighting of the rendered model. See 
Chapter 4, Lighting. 

PATHS Control the animation feature. See Chapter 6, 
Animation. 
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RENDER Control the rendering of images, animation and 
panoramas. See Chapter 5, Rendering, Chapter 6, Walk-
through Animation.. 

TOOLS Control ARC+ Render Pro tools: show/hide scene 
tree view and status bar; customize toolbars, texture 
libraries, icon list; control ARC+ Render Pro options. 

WINDOW Control the arrangement of windows on the screen: 
new window, cascade, tile, arrange icons; see a list of 
the open windows; control configuration of the 
windows displayed on the screen. 

HELP Access help utilities; view information about the user, 
the software and the system resources. 

The Standard Toolbar 
You can use Windows standard toolbar to perform standard operations without 
having to select commands through the menu: generate a new file, open an 
existing file, save a file, cut, copy, paste, undo, redo, print, print preview and get 
information about ARC+ Render Pro. 

 

The Viewing Toolbar 

Windows Display Control 
In the rendering mode, the model is graphically displayed in three different 
work windows.  A specific angle of view for each of these windows can be 

selected from the pull-down view menu in the tool bar.  

A view is added by adding a camera. See Chapter 3, Cameras 
for full information.  The active window is named 
accordingly, and its name is added to the list. 



  Getting Started 

ARC+ Render Pro User's Guide  1-11 

View Control 
You can adjust the view of the model within the active window by clicking the 
icons in the Viewing toolbar displayed below.  

 
These icons are entirely independent of the view settings in the modeling mode. 
When you return to the modeling mode, your original view is restored. 

The function of each viewing icon is described below: 

 
ZOOM OPTIONS From left to right: Zoom full - zoom the view to fill 

the window (including model and all objects). Zoom 
work area - only model view fills the window. Zoom 
object - zoom on selected object. Zoom all windows - 
toggles between zooming all windows and only 
active window. 

 
TOGGLE Toggles the view between the perspective and the  
PERSPECTIVE/PARALLEL parallel angles. 

 
ZOOM BY RECTANGLE Drag the mouse to define a rectangle around part of 

the model. The rectangle area fills the window. 

 
PAN BY LINE Drag the mouse to move the model in the window 

along the drawn line. 

 
ZOOM DYNAMIC Move the cursor upwards to zoom up, downwards to 

zoom down.  

 
PAN DYNAMIC Grab the model with the hand, and pan it in any 

direction. 

 
WALK DYNAMIC Move the cursor in any direction to advance in the 

model. 

 
STUDY DYNAMIC Move the cursor in any direction to rotate the model 

 
STICKY MODE Use sticky note in order to keep any of the above 

buttons pressed when you release the mouse button.

 
 ANIMATION OPTIONS From left to right: Number of key frames created.  

Play.  Stop.  Go to first frame. Go to previous key 
frame. Go to previous frame. Go to next frame.  Go to 
next key frame.  Go to last frame.  Add key frame.  
Delete key frame.  Make key frame. 
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 LOOK EDITOR OPTIONS Moves textures to create variations.  From left to 

right: Move texture left.  Move texture right.  Move 
texture up.  Move texture down.  Rotate texture left.  
Rotate texture right.  Decrease texture scale X.  
Increase texture scale X.  Decrease texture scale Y.  
Increase texture scale Y.  Increase blending.  Decrease 
blending. 

 
ATTACH OPTIONS From left to right: Attach to entity.  Attach to solid.  

Attach to layer.  Attach to color. 

 
 VIEWING DISCRETE 

OPTIONS Viewing of a certain area.  From left to right: Zoom 
in.  Zoom out.  Pan left.  Pan right.  Pan up.  Pan 
down.  Forward.  Backward.  Move observers eye 
position toward or away from the target location by a 
fixed distance: Rotate left.  Rotate right.  Rotate up.  
Rotate down. 

Customizing the Viewing Icons 
Customize the operation of the viewing icons using the following command:  
 
 

 

Tools 
Options 
Viewing  

 
From the command toolbar select TOOLS > OPTIONS and click the viewing discrete 
tab. The Options dialog box is opened.  Options can be changed at any time.  
Your latest choices become the defaults for your next ARC+ session. 
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ZOOM BY RECTANGLE Controls the way in which the rectangle is drawn 

when using Zoom by Rectangle. (See above, View 
control).  

BY TWO CORNERS The rectangle is drawn when dragging the mouse 
indicates the center of the rectangle and one corner. 

BY CENTER AND CORNER The rectangle is drawn when dragging the mouse 
indicates two corners of the rectangle. 

INDICATION (PICK) Controls the way an object is picked, indicated, when 
pointing to it with the mouse. This is most 
conspicuous in Wire Frame mode. 

BY SENDING A RAY 
TO OBJECT A light ray is sent to indicate the object positioned 

where the mouse cursor stands.  

BY SENDING A LINE 
BELONGING TO OBJECT The object is picked by tracing the line on which the 

mouse cursor stands.   
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SENSITIVITY PIXELS Set the sensitivity levels corresponding to the object 
picked. 

The Draw Toolbar 

Control the display in the active window using the draw toolbar. This function 
can also be performed from the VIEW menu. 

 

 
WIRE FRAME  View only the polygons forming the model (the 

default display). 

 
NO SHADING  View the rendered model without shading effects. 

 
DYNAMIC RENDERING View rendered model with lighting and shadow 

effects, defined during dynamic rendering. 

 
RAY TRACE WHOLE  
WINDOW View model in highest quality rendering, including 

transparencies and reflections. 

 
RAY TRACE BY 
RECTANGLE Define a rectangle part of the model to view in the 

ray tracing mode. 

 
RAY TRACE PUZZLE View model in ray tracing mode, when the ray 

tracing process starts with an initial, low resolution 
display and evolves to the final result. (As opposed to 
default manner, displaying ray traced model “line by 
line”). 
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The Library bar 

The library stores rendering attributes such as 
textures, materials and colors, which can be easily 
applied to selected surfaces in a model. Rendering 
attributes can be dragged-and-dropped directly from 
the library bar onto an object, or into an object’s 
properties dialog-box. The attributes are discussed in 
Chapter 2, Attributes. 

The library bar is arranged according to the 
rendering attributes types e.g. textures, materials, or 
colors.  

Each library contains categories (folders and 
subfolders). The folders contain the rendering 
attributes i.e. textures, colors etc., arranged 
according to subjects. Double-clicking on a folder 
opens it and displays its content. 

 

 

 

 

Customizing the Library bar 
The Library bar can be customized in a number of ways: you can customize the 
library bar appearance and add or remove libraries.  

 

Customizing the library-bar appearance 
Right-click inside the library bar and select Options.  

In the dialog box that opens you can adjust various library’s bar appearance 
settings. 
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Under the Options tab in the options dialog-box, you can turn the appearance of 
all available folders on and off. 

Click Apply to see the changes you made to the library appearance. 

When you are done, click ok. 

Customizing the list of libraries 
To add or remove a library (Library is a collection of rendering attributes of the 
same type, i.e. textures, materials, colors - stored under folder on your disk or 
CD-ROM), Select Tools > Customize from the menu bar. In the dialog box that 
opens, click the Libraries tab. 
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Select a library type from the drop-down menu.  

Use the icons on the right to add or remove a library.   

 

 To add a new library, click on the icon. In the dialog 
box that opens, enter a name for the new library, and 
enter a path to the folder containing the new textures.  

 

 Delete a library from list. (select the required folder 
first) 
 

 NOTE: Standard library cannot be deleted from list  
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 Move a library up the list (select the required folder 
first) 

 Move a library down the list (select the required 
folder first) 

 
To specify a library as read-only, check the Read-only check box. Read-only 
libraries cannot be edited (see Chapter 2, Attributes, Editing the library). 
 

File and Library Operations 

When you render a model, the rendering attributes of model entities are stored 
together with the model in the model file. These attributes include: 

� Rendering colors 
� Materials 
� Textures 
� Smoothing 

View, lighting and rendering options are stored in a special pair of rendering files 
(not stored in the regular model files). These have the same filename as your 
model and the .GRB and .GRT file extensions. When you open or save a model, the 
rendering files are opened or saved as well.  

Using the same Rendering Files for all Models in a Directory 
When you edit or create new material and texture definitions (see Chapter 2, 
Attributes, Defining attributes), the definitions are saved in the rendering files 
(*.GRB and *.GRT). In addition, the rendering files contain all your view, lighting, 
and rendering option settings. 

You can transfer the material and texture definitions and other settings from one 
ARC+ model to another, by using the same rendering files for the models. 
 

 
 
 

Tools 
Options 
Model  

 
The OPTIONS dialog box is opened. 
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Select the USE COMMON RENDERING FILE option, and specify a filename (1-8 
characters with no extension). When you open another model in the same 
directory, the definitions and settings are automatically available for use. 

Saving Blanking of Placed Elements 
If you blank or unblank placed elements within ARC+ Render Pro, you can 
select whether to preserve the blanking status when you leave the rendering 
mode (see Modeling and rendering modes later on in this chapter.). To save 
blanking status of placed elements select: 

 
 
 

Tools 
Options 
File Types 
Options 

 
The FILE TYPE dialog box is opened. 
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You may select: 

DON'T SAVE All your blanking settings are lost when you leave 
the rendering mode. 

PROMPT BEFORE SAVING You are prompted whether to save or cancel the 
blanking status of each element when you leave the 
rendering mode. 

ALWAYS SAVE The blanked or unblanked status of all placed 
elements is saved in the model files. The objects 
remain blanked or unblanked in both the modeling 
and rendering modes. 

LOAD 2D ENTITIES Although 2D entities (lines and arcs) can be displayed 
on the ARC+ Render Pro editing screens, they cannot 
be rendered because they do not contain surfaces that 
reflect light. The 2D entities are not included in any 
rendered image. Check this option if you want to add 
them to the saved file. 

 NOTE   Like all other ARC+ editing, the blanked or unblanked status is saved in the 
permanent disk copy of your model only when you use the ARC+ \save command. 
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File Properties 
The Properties dialog-box stores and displays various file details, such as the 
file’s title, author’s name, comments, summery, various statistical details, etc. 
Use file properties to store and display information about a file that will help 
identify and organize it. To open the file-properties dialog box, select File > 
Properties from the menu bar. 
 

Packing 
ARC+ Render Pro project contains the following files:  

� Model files 
� Placed files 
� Library files 
� Rendering files 
� Custom texture and material files that don't exist on the destination system 
 
ARC+ Render Pro automates the transfer of a project by allowing you to pack 
and unpack the complete set of project files. To prepare a project for transfer, 
select the pack command in the rendering mode: 
 

 
 
 

File 
Pack Model 
 

 
ARC+ Render Pro identifies the required files and compresses them into a single 
file for easy transfer. You are prompted for a filename (with the extension .ZIP) 
and directory location to save the file. 

On the destination computer, select the unpack command to decompress the 
files: 

 
 
 

File 
Unpack Model 
 

 
ARC+ Render Pro opens the .ZIP file and installs all the component files in the 
required locations. You are prompted for a directory to store the unpacked 
model. 

Selecting the Files to Send 
If you know that some of the required files already exist on the destination 
system, you can reduce the size of the pack file for a large project. To do this, 
select the following command: 
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Tools 
Options 
 

 
From the OPTIONS dialog box, select the ADVANCED tab. 

 
In the dialog box, select the files that you need to send: 

PACK RENDER 
ATTRIBUTES FILES 

Include custom texture and material definitions in the 
pack file. 

PACK SYSTEM LIBRARY 
FILES 

Include files from the ARC+ system library. 

 

Copying Library Objects 
It is important to keep in mind that as you work in ARC+ Render Pro, you can 
assign rendering attributes to library objects that are placed in your model. 
When you save the model, ARC+ Render Pro saves the attributes as the new 
defaults in the original library model. If you later render another model 
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containing the same library object, it already contains these rendering attribute 
defaults. 

This can be undesirable if you want to render different models with different 
attributes for library objects.  
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To change this, select:  

 
 
 

Tools 
Options 
 

 
From the OPTIONS dialog box, select the ADVANCED tab. 

 
 

SAVE IN ORIGINAL 
OBJECT 

Save all attributes in the original library object. 

COPY OBJECT TO MODEL 
DIRECTORY 

Assign an attribute to a library object, ARC+ Render 
Pro prompts you to copy the object to the model 
directory. The attributes are saved with the copy and 
do not affect the original library version. 

COPY ONLY IF ORIGINAL 
IS READ ONLY 

If the original object is a read only file or in a read 
only directory, ARC+ Render Pro prompts you to 
copy the object to the model directory. For read/write 
objects, ARC+ Render Pro saves the attributes in the 
original file. 
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Customizing the Model Display 

In the rendering mode, you can control the mode of view of the selected work 
window and customize the model display: 

From the menu, select VIEW and select one of the following pull-down menu 
options: 

WIRE FRAME  View only the polygons forming the model (the 
default display). 

HIDDEN LINES View polygons forming the model, with hidden line 
removal. 

SHADED View flat textures, with shading effects. This option 
might result in faster display than flat rendering. It 
requires OpenGL or DirectX software (distributed 
with latest versions of Microsoft Windows operating 
systems). 

NO SHADING View the rendered model without shading effects. 
View the textures and colors applied to entities in the 
model, without the effect of the light sources; The 
model has uniform, white light. 

DYNAMIC RENDERING View rendered model with lighting and shadow 
effects, defined during dynamic rendering. 

RAY TRACING View highest rendering quality (including 
transparencies and reflections). Whole window, by 
rectangle, puzzle. 

REFRESH Re-draws the current work window. 

OPTIONS Control additional options. 

 NOTE that some of these functions can also be performed from the draw toolbar. 

Control the view of the model in the selected work window by controlling the 
view options: 

� Show cameras and lights 
� Display the model in gray instead of color 
� Simplify and speed up the model display 
� Remove hidden lines from the display 

 View 
Options 
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Use the dialog box to specify the default method of display. You can override 
your default settings at any time using the pop-up view menu (see Windows and 
viewing icons earlier in this chapter). 

 
Select the element you want to display. 

In the WIRE FRAME mode, you can define more options: 

 View 
Options 
Draw 

 

  
GRAY DRAWING Use this option to simplify the display when you set 

the locations of objects such as light sources. 
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QUICK DRAWING Simplify and speed up the display of a complex 
model by means of partial display: e.g., every third 
polygon, and every second line (see Defining ARC+ 
Render Pro Options).  

BACK FACE CULLING  Obtain a more realistic wireframe display. To speed 
up the display, hidden lines are only partially 
removed. 

SMOOTH  
(DOUBLE BUFFER) 

By default, ARC+ Render Pro starts to display a 
model while computations are in progress. If you 
select the USE DOUBLE BUFFER option, the changed 
model is displayed only when the computations are 
complete. 

UCS  
(COORDINATE SYSTEM) 

Adds a set of coordinates to the selected window. 

WINDW SIZE Set the window size (width and height of the 
window). To keep aspect ratio, check the KEEP ASPECT 
RATIO check box.  

To automatically fit preview window size to image 
aspect ratio, click IMAGE  ASPECT RATIO. 
 

 
 

Customizing the Scene Tree 

The scene tree presents the elements involved in the rendering process: Lights, 
cameras, layers, colors, solids and placed elements. Each element display can be 
expanded or collapsed, using Windows conventions (+ and -). 

The types of the displayed elements are defined from the ATTRIBUTES menu, as 
follows: 
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DYNAMIC EDITING  Display all element types. 

COLOR MAPPING Display only colors. 

LAYER MAPPING Display only layers. 

LIGHTS Display only lights. 

CAMERAS Display only cameras. 

Select VIEW > OPTIONS to customize the way the scene tree is displayed: the order 
and content of the elements. The SCENE TREE OPTIONS dialog box is opened. 

 



  Getting Started 

ARC+ Render Pro User's Guide  1-29 

Check the types of elements you wish to be visible on the scene tree. To 
determine the properties of the selected element, select the PROPERTIES tab.  

The selected element properties dialog box is opened. Note that the dialog box 
differs according to the type of element (see Chapters 3 through 5). 

Editing the Scene Tree and Adding Elements 

Elements (such as camera and lights) in the scene tree can be edited like any 
Windows application, using cut, copy, paste, delete and rename.  Elements 
added to the scene tree are immediately displayed in all the other work 
windows.  Right-click any scene tree element to display a pop-up menu. The 
pop-up menus vary according to element type  (see Chapters 3 through 5 for each 
element type). 

Customizing the Workspace 

The commands found under the layout View menu, move you among the 
various layouts available in Arc+ render Pro. When you choose one of the 
layouts, the appropriate set of elements is displayed. Their location in the scene 
is displayed in the top and front views on the right side of the perspective 
screen. 

You can customize layouts by saving altered layouts or saving new ones.  

In the example below, the lights layout is selected. Note that the location of the 
lights is marked in the top and front views on the right. If you select one of the 
lights in the list on the left, this light-element will be highlighted in the top and 
front views.  
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In this working mode you can edit each element as follows: 

� Clicking on an element, either in the list on the left or in one of the scene-
views on the right, will highlight this element and adjust the scene in the 
perspective screen accordingly 

� Right-clicking on an element in the list, on the left-bottom side of the 
screen, will present you with a complete list of all the editing options 
available for this element 

� Double-clicking on an element, either in the list on the left-bottom side or 
in one of the scene-view on the right, will display its properties dialog box  

� Clicking on the element in either the top or front view on the right and 
holding down the mouse, you can drag an element to change its location 

 

 View 
Layouts 
 

 

The available options in the layout popup menu under Views are: 
Dynamic editing Displays a list of all available elements in an 

hierarchic tree which can be collapsed and expanded. 
These include cameras, lights, layers and colors. It 
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does not show elements in the top or front views on 
the right 

All other layouts Display a layout of the corresponding elements 
(Color Mapping, Layer Mapping, Cameras, Lights, 
Camera Path, Light Path) and show corresponding 
elements in the top and front views on the right 

Start This layout is displayed when you open a model 

Save Layout Allows you to save the layout in its current 
configuration. You can save the layout under its 
present name, or create a new layout by typing a new 
name in the dialog box that opens when you choose 
‘Save Layout’ 

Define Layout Allows you to copy, rename, delete, reset and set a 
layout as the current layout 

 

Alternatively, you can also use the layouts toolbar to display the main layouts. 

To display the layouts toolbar:   

Select Tools > Customize from the menu bar, click on the Toolbars tab and check 
the Layouts box. 

Modeling and Rendering Modes 

Keep in mind that you can perform many of the rendering operations within the 
modeling mode of ARC+. You can execute both ARC+ editing and ARC+ 
Render Pro commands, and you can mix the commands in any order that you 
prefer.  

Alternatively, you can enter the rendering mode (ARC+ Render Pro), where you 
can combine many rendering commands in a single integrated operation. When 
you enter the rendering mode, the screen changes to a different layout, where 
the results of most rendering commands are immediately displayed. 

The rendering commands are executed more rapidly and more conveniently in 
the rendering mode. Unless you want to mix ARC+ editing and rendering 
commands, it is recommended that you use the rendering mode for most 
rendering operations. 
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To Enter the Rendering Mode 
To enter the rendering mode, select one of the following pull-down menu 
options: 
 
\grdyned 
 
 

Attributes 
Dynamic Editing 
 

 
\grlight 
 
 

Lights 
Graphic Editing 
 

 
\greview 
 
 

Cameras 
Graphic Editing 
 

 
\ Paths 

Camera Path 
 
In the rendering mode, select ARC+ Render Pro commands from the toolbar. 

 IMPORTANT   You cannot perform the following operations in the rendering mode: 

� Entering ARC+ editing (nonrendering) commands 
� Typing command names or parameters on the input line (there is no input line in the 

rendering mode) 

 To perform any of the above operations, return to the modeling mode. 

Returning to the Modeling Mode 
To leave the rendering mode and return to the normal ARC+ screen, select the 
following command from the pull-down menu: 
 
 
 
 

File 
Exit 
 

 

Blanking Layers of ARC+ in the Rendering Mode 
You can blank or unblank ARC+ layers without exiting the rendering mode. 

Select the required layer from the SCENE TREE 
window and right-click the mouse. The following 
menu is opened.  

 

Un-check VISIBLE.  
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 NOTE  Your settings temporarily override any settings that you may have made using 
the Blanking layers (\lblnk) command before entering the rendering mode. Your 
previous layer settings are restored when you return to the modeling mode. 

 NOTE   To preserve the blank or unblanked status when you leave the rendering mode, 
see Model and Rendering Files. 

Customizing ARC+ Render Pro Screen 

To customize your desktop and work environment to reflect your preferences: 

 
 

Tools 
Customize 
Toolbars 

 
The CUSTOMIZE dialog box is displayed. 
 

 
Check the toolbars you want displayed on the screen.  
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The Libraries tab enables you to customize the 
Texture and/or Model libraries you want 
displayed and specify their directory (path). 
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The Icons List tab enables you to select the size assigned to the displayed icons 
(specified in pixels), to display the icon's name and to specify whether or not to 
preserve the original aspect ratio. 

Customizing the ARC+ Render Pro Window 

You can configure the appearance of the rendering-mode screen by configuring 
the display of the view windows. 
 

 
 

Windows 
 

 
Select the following options: 

NEW WINDOW A new, large view window is displayed in the middle 
of the screen, on top of all other windows. 

CASCADE Four windows are arranged like a card pack. Click on 
a window in order to bring it forwards. 

TILE Four windows are sharing the display area, side by 
side. 

ARRANGE ICONS  Arrange icons on screen. 
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Rendered Images 

ARC+ Render Pro provides numerous options that control how rendering is 
performed. For an initial impression of the design, select a flat-shaded option 
that computes a clear image in just a few seconds. For the highest quality 
rendering, select a ray-traced image that displays high-quality effects.  

The rendered image of a model is stored in an image file in the current directory 
of your hard disk. A variety of different image file formats are available, for 
example .TIF, .PCX, or .BMP. This enables you to transfer the image to other 
software systems, for example graphics or desktop publishing systems. 

Typical Working Process 

ARC+ in conjunction with ARC+ Render Pro, provides many options for 
creating and rendering your model. Each ARC+ user develops his or her own 
style of design, and it would be difficult to define a "normal" procedure for 
work. 

What follows is an example of one possible procedure for rendering a model. 
The example does not include all of the possible ARC+ Render Pro commands 
and options. The order of commands can be altered, and you can mix rendering 
commands with ARC+ editing commands. 

 
 

Menu Commands Description See Chapter and Section 
Any ARC+ editing commands 
(on the main ARC+ menu) 

Create or open an ARC+ model Getting started, Preparing the model 

 Display the ARC+ Render Pro menu Getting started, Entering ARC+ 
Render Pro commands 

Attributes 
Dynamic Editing 
 

Enter the rendering mode and assign 
rendering colors, materials, and 
textures to the entities and background 
of your model 

Attributes, Assigning attributes to 
entities  

 

Attributes 
Lights  
Lights 
Ambient  Light 

Set the lighting scheme, for example 2-
3 light sources plus ambient light 

Lighting 
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Menu Commands Description See Chapter and Section 
Cameras 
Graphic Editing 

Set the rendering view 
 

Cameras, Setting the view in the 
rendering mode 

Render 
Image setting 

Set the image file name, type, and size Rendering, Image file types 

Render 
Quality setting 

Set the rendering quality options Rendering, Rendering Quality 

File 
Exit Rendering Mode 

Return to the modeling mode Getting started, Modeling and 
rendering modes 

File Save Save the model and rendering files In the ARC+ User's Guide: Files, 
Saving a file 

Render 
Render/Ray Tracing 

Produce and display the rendered 
image 

Rendering, Producing the rendered 
image 
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AttributesAttributesAttributesAttributes    

 
This chapter defines rendering attributes and explains how to assign attribute 
values to entities using ARC+ Render Pro commands. 

An ARC+ design model consists of three-dimensional components called entities. 
The surfaces of these entities are displayed in a rendering of the model. By 
assigning attributes to an entity, you instruct ARC+ Render Pro how to treat the 
surfaces of the entity in the rendering. 

The attributes that you can assign are: 

COLOR Any of 16,777,216 distinct combinations of the red, 
green, and blue primary colors. 

MATERIAL A specified combination of properties representing 
how the entity interacts with light: transparency, 
diffuse (dull) or specular (shiny) reflection. 

TEXTURE Any of a large variety of realistic textures, such as 
wood, brick, paving, etc. 

SMOOTHING The degree to which sharp edges of a solid entity are 
smoothed in the rendered image. 

BILLBOARD The behavior that the element is automatically 
rotated towards the camera. 

You can assign attributes in either the modeling or the rendering mode. If you 
work in the rendering mode, you can define a lighting scheme and background 
for your model while you assign the attributes, and you can immediately 
preview the effect of your assignments on the rendered image. 
 

2
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Defining Attributes 
This section explains the meaning of rendering attributes and how to define 
attribute values using ARC+ Render Pro commands. 

Colors 

Specify colors using one of the methods described below. 

RGB Colors 
You specify colors using RGB definitions. RGB defines colors using the three 
primary color components (red, green and blue) which are the basis for a video 
image. A number from 0 to 255 defines how much of each component color is 
present in the RGB color. Some useful definitions appear in the table below. 

Color R (Red) G (Green) B (Blue) 
Black 0 0 0 
Red 255 0 0 
Green 0 255 0 
Blue 0 0 255 
Cyan 0 255 255 
Magenta 255 0 255 
Yellow 255 255 0 
White 255 255 255 

 
The RGB concept includes both the shade and the brightness of color. White, 
gray, and black, for example, can all be produced by adjusting the RGB 
component values. There is no need for a separate color brightness setting in the 
RGB system. 

Using the Color Dialog Boxes 
There are several ways to define a color in ARC+ Render Pro dialog boxes: 

� Slide the RGB slide bars. 
� If a color palette is displayed, click one of the palette entries. You may then 

modify the color by moving the slide bars. 
� Make the RGB text areas active and type the desired amount of each primary 

color (0-255). 
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� Anywhere in ARC+ Render Pro where a color sample is displayed, you can 
double-click the sample to display the COLOR ATTRIBUTE dialog box. Select 
from the palette or use the slide bars to change the color as desired.  

 

 
 

Other Color Systems 
You can use several methods to specify 
colors in ARC+ Render Pro: 

The HSL colors are specified by 
numerical color coordinates, similar to 
RGB. In the Name system, colors are 
specified by names such as gray, forest green, or goldenrod.  
 
To display a palette of colors in any of the dialog boxes, double-click in the 
sample colored area. 

To name a color, right-click a color area or a color element in the scene tree and 
open the PROPERTIES dialog box. 

 NOTE   You may use the systems interchangeably and switch back and forth while 
working on the same model. The RGB and HSL alternatives produce an identical gamut 
of colors. The Name system is more limited, as you can produce many RGB or HSL 
colors that have no defined name. 

Color system Explanation 
RGB Red Green Blue 
HSL Hue Saturation Luminance
Name Name of color 
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Naming a Color 
In the attributes record of an entity, rendering colors are specified by name. The 
name is an ampersand symbol (&) followed by the RGB component values of the 
color. For example, the name &255:255:255 refers to white and the name &0:255:0 
refers to green. 

If you assign a rendering color in the modeling mode and you know the name of 
the color, you can type the name on the input line without using a dialog box. 

 NOTE   Use this naming system only in ARC+ Render Pro commands. In other 
(nonrendering) ARC+ commands, use the standard palette of fifteen colors which you 
specify by number (1-15). 

Default Color and Conflicts with Texture 
If you assign no rendering color to an entity, then the entity is rendered with its 
ARC+ color from the standard 15-color ARC+ palette. 

If you assign both a color attribute and a texture attribute to an entity, then the 
texture is used to form the rendered image and the color is ignored. To change 
the color of a texture, use the Edit texture command. 

See Combining attributes later in this chapter for further information on these 
rules. 

Editing a Color 
Using the Edit Color dialog box, you can adjust or change the RGB color 
assigned to any entity. 

Materials 
In ARC+ Render Pro, a material attribute determines how light is treated when 
it strikes an entity's surface, which is important for determining shading 
characteristics, highlights, reflections, and transparency of the rendered image. 

The material definition includes only optical properties, that is, those properties 
that affect the way you see the image. Other material properties such as 
mechanical strength, etc., are omitted from the material definition as they have 
no effect on the rendered image. 

The optical properties of materials are fully exploited if you use the ray tracing 
method to form the rendered image (see Chapter 5, Rendering).  

Characteristics of a few typical materials are given in the following table. 
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 Optical Properties 
Material In both rendering 

and ray tracing 
Additional properties 

in ray tracing 
Aluminum Medium shiny 

 
No reflectance 

No transparency 
Chalk Dull 

 
No reflectance 

No transparency 
Glass Shiny 

 
Low reflectance 

High transparency 
Mirror Shiny 

 
High reflectance 

No transparency 
Plastic Medium dull 

 
No reflectance 

No transparency 
 
You can edit the properties of a material to define new materials with properties 
that you desire. 
 

Chalk table top Glass table top Mirror table top 

      
 

Using the Material Dialog Boxes 
Select a predefined material from a palette. If you edit and save a material 
definition, choose the icon of the original (unedited) material from the palette. 
Either double-click the icon or right-click the mouse and select PROPERTIES. A 
MATERIAL dialog box opens, consisting of two tabs: GENERAL, for naming the new 
material and SETTING, for editing its optical properties. 
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Naming a Material 
In the attributes record of an entity, materials are specified by name selected 
from drop down menu. The predefined materials have simple names, such as 
glass. If you create a new material definition by editing a predefined material, 
you give it a subname, e.g., glass:stained, by typing in the DESCRIPTION text area. 

If you know the name, you can specify a material in the modeling mode by 
typing on the input line without using a dialog box. 

 NOTE   Type the name using capital and small letters exactly as it appears in a dialog 
box or attributes record. 

Default Material 
If you do not assign a material attribute to an entity, it is rendered using the 
default, a dull opaque material with no other special properties. 

See Combining Attributes later in this chapter for further information on this 
subject. 

Editing a Material 
You can edit the optical properties defining the material of an entity (in effect 
defining a new material), using the SETTING tab in the MATERIAL dialog box. 
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The following parameters appear in the dialog box and are used in both the 
rendering and the ray-tracing methods: 
 

  
DIFFUSE Light reflected from a surface of the material and 

scattered in all directions; dull reflection (range 0-1, 
default 1). 

SPECULAR Light reflected from the material near the mirror 
direction; shiny reflection (0-1, default 0). 

SHINY Angular distribution of specular reflection about the 
mirror direction; higher values give a narrower 
distribution and sharper highlights on the material. 

TRANSPARENCY Fraction of light transmitted by a surface of this 
material onto other surfaces in the model (0-1, default 
0). (Effective only in the Phong and Ray-tracing 
methods). 

REFRACTIVE  Ratio of the speed of light in vacuum to the speed of 
light in the material. This determines how a ray of 
light is bent when it passes through a transparent 
material such as glass, plastic, or water. The value is 
near 1.5 for most materials. (Effective only in the 
Phong and Ray-tracing methods). 

FADE Decay of reflected or transmitted light intensity with 
distance from a surface of the material. A fade value 
of 0 means that the light intensity does not decrease 
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with distance. Larger values mean that the intensity 
decays more rapidly with distance (0-2, default 0). 
(Effective only in the Phong and Ray-tracing 
methods). 

REFLECTANCE Fraction of light reflected by a surface of the material 
onto other surfaces in the model (0-1, default 0). 
(Effective only in the Phong and Ray-tracing 
methods). 

AMBIENT Uniform, non-directional light of any RGB color 
illuminating the material. Use this parameter to 
ensure that surfaces of this material are not 
completely black in the rendered image (default 0). 

SHADOWS The material casts shadows on surfaces behind it. For 
unusual lighting effects, you can turn off shadows for 
a material. 

 HINT   Materials with low diffuse reflection (e.g., mirror or glass) tend to look dark in 
renderings produced with the flat or Gouraud shading options. If this is a problem, use 
the Phong or ray tracing shading option instead (see Chapter 5, Rendering, Shading 
options). 

Geometrical Characteristics 
There are several differences in the behavior of materials when you apply them 
to a solid entity with different geometrical characteristics. To view the effect of 
applying a material to a three-dimensional solid, you can define the geometrical 
character of the solid. 

From the pull-down menu in the properties dialog box  select: CYLINDER, 
RECTANGLE, SPHERE or MATERIAL (two-dimensional). You can remove the 
GEOMETRICAL CHARACTERISTICS option from the dialog box by clicking the << 
button. 

Textures 

There are two types of textures in ARC+ Render Pro: 

TWO-DIMENSIONAL A predefined pattern that is applied repeatedly to 
cover the surface of a polygon or solid entity. 

THREE-DIMENSIONAL A computed pattern that is applied to the surface of a 
polygon entity or throughout the body of a solid 
entity. 
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There are several differences in the behavior of these textures when you apply 
them to a solid entity. 

Thus, with two-dimensional textures, lines of the pattern (e.g., wood grain) may 
not be continuous or consistent at the edges of a solid entity. Three-dimensional 
textures fill the entire body of the solid, so lines are continuous and consistent at 
all edges.  

You can apply a two-dimensional texture nonglobally onto each surface of a solid. 
Alternatively, you may apply it globally around all sides of a simple solid 
(prism). If you do this, the pattern is rescaled and wrapped around the sides of 
the solid. In the GLOBAL option, the texture is not applied to the top and bottom 
base polygons of the solid; you can apply the texture separately to the base 
polygons if you wish. 

You may also apply a texture globally to a rotational solid (see Polygons and 
solids, Creating a solid by rotating a polygon, \rosol command, in the ARC+ User's 
Guide), provided the solid meets the following criteria: 

� The upper and lower bases of the solid are perpendicular to the rotation axis. 
� No other surfaces of the solid are perpendicular to the axis. 
� The solid has a diameter that is greater than zero in all directions 

perpendicular to the axis. 
� The solid was created by a rotation of 360°. 

 NOTE   If you try to apply a texture globally to a complex solid that does not meet these 
criteria, then it is applied nonglobally. 

The GLOBAL and NONGLOBAL options are not relevant to three-dimensional 
textures. 

Some of the available texture categories are listed below.  
 

Texture Category Typical Textures in Category 
Art Paintings and works of art 
Brick Brick and tile patterns 
Carpet Carpets and upholstery 
Cloth Fabrics and upholstery 
Cork Cork 
Drinks Soft-drink labels 
Granite Granite and stone 
Marble Marble 
Paint Rough painted surfaces 
Parquet Wood patterns 
PVC PVC flooring 
Rug Coarse rugs 
Stone Patterned stone and concrete 
Wood Wood materials 
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You can edit the properties of a texture to define new textures with patterns that 
you desire. 

Art Brick Carpet Cloth Cork 

   

Drinks Granite Marble Paint Parquet 

   

PVC Rug Stone Wood  

  

 

  
2D texture applied nonglobally 2D texture applied globally 3D texture 
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Using the Texture Dialog Boxes 
Select a texture from a palette. 

Two-dimensional textures are displayed as patterned squares in the palette. The 
size of the square is one repeat unit of the texture pattern. 

Three-dimensional textures are displayed as columns of marble, logs of wood, or 
other three-dimensional objects within a solid-color square. The size of the 
square is 1 x 1 meter, providing a visual guide for the scale of the texture. 

If you edit and save a texture definition, choose the icon of the original 
(unedited) texture from the palette. The dialog boxes then provide either an 
additional scroll box or an EDIT icon by which you can choose your edited 
version. 

To open the TEXTURE dialog box, select a texture from the palette. Either double-
click it or right-click and select PROPERTIES. A dialog box with 4 tabs is opened. 

 

Naming a Texture 
In the attributes record of an entity, textures are specified by category and name, 
selected from drop down menu, for example WOOD:budinga. If you create a new 
texture definition by editing a predefined texture, you give the texture a 
subname, for example WOOD:budinga:dark. 

If you know the category and name, you can specify a texture in the modeling 
mode by typing on the input line without using a dialog box. 

 NOTE   Type the category and name in capital and small letters exactly as it appears in 
a dialog box or attributes record. 
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Default Texture and Conflicts with Color 
If you assign no texture to an entity, then the entity is rendered without texture. 

If you assign both a color attribute and a texture attribute to an entity, then the 
texture is used to form the rendered image and the color is ignored. 

See Combining attributes later in this chapter for further information on this subject. 

Editing Texture Size and Orientation 
You can edit the properties of a texture using the TEXTURE dialog box SIZE tab. 
The fields and options in this box vary depending on the type of texture you are 
editing. 
 

 
 
For two-dimensional textures, you can change the scale or rotate the texture on 
the surface to which it is applied: 

ABSOLUTE/RELATIVE Select ABSOLUTE if you want to specify the other 
texture options (SIZE, GAP, and OFFSET) in your ARC+ 
working units (e.g., meters). Select RELATIVE if you 
prefer to specify the other options as a fraction or 
percentage of the polygon to which the texture is 
applied. 

SIZE Horizontal and vertical dimensions of the texture 
pattern unit (the unit that appears in a dialog box 
icon). 
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In the ABSOLUTE option, increasing the SIZE enlarges the texture. In the RELATIVE 
option, SIZE is the number of times that the texture pattern unit is repeated on 
the surface, i.e., increasing SIZE makes the texture unit smaller. 

GAP Leaves a horizontal or vertical space between 
repetitions of the texture within the polygon. 

OFFSET Displaces the starting point of the texture repeat 
pattern in a horizontal or vertical direction within the 
polygon. 

If you select ABSOLUTE, specify OFFSET and GAP in your working unit (e.g., 
meters). If you select RELATIVE, specify OFFSET and GAP in percent of the texture 
unit dimensions. 

REPEAT Portion of the polygon surface that the texture covers 
in the horizontal and vertical directions. The default 
value of 0 means that the entire surface is covered. 
Specify nonzero values if you want to cover only part 
of the surface. 

Specify repeat as the ABSOLUTE dimensions that you want to cover, e.g., 1 m 
horizontally x 2 m vertically, or as the RELATIVE number of times that the unit 
should be repeated, e.g., twice horizontally and three times vertically. 

The REPEAT value is the maximum coverage of the surface. If you specify a REPEAT 
value that is larger than the entire surface (e.g., REPEAT = 10 m on a 2 m surface), 
then the entire surface is covered. 

ROTATE Orientation angle of the texture on the surface  
(0-360�). With an angle of 0�, the first corner point of 
the pattern (bottom left of the dialog box icon) 
coincides with the first point that you defined when 
you created the polygon. The second corner point 
(top left of the icon) lies on the line between the first 
and second points of the polygon. With a rotation 
angle not equal to 0�, the pattern is rotated from this 
orientation. 

To edit additional orientation properties of a texture use the TEXTURE dialog box 
TILE tab. 
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TILING MODE Determines how alternate texture units are oriented 

relative to one another throughout the polygon. 
Options are normal (all units oriented in the same 
direction), mirror xy (alternate units are flipped in 
both the horizontal and vertical directions), mirror x 
(flipped in the horizontal direction only), and mirror y 
(vertical direction only). 

FLIP Reflects the texture pattern unit in the horizontal or 
vertical direction. 

To edit the alignment property of a texture use the TEXTURE dialog box MISC tab. 

ALIGNMENT The direction in which the vertical dimension of the 
texture unit is placed. Options are polygon (i.e., the 
texture is placed parallel to the first side of the 
polygon), x axis, y axis, and z�axis. Choose z axis, for 
example, to ensure that a brick texture is placed 
parallel to the true vertical direction of your model. 

 NOTE   The GAP, OFFSET, REPEAT, TILING MODE, FLIP, and ALIGNMENT options are 
effective for textures applied to polygons or applied nonglobally to solids. 
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Editing Texture Colors 
For two-dimensional textures that contain only two colors, you can edit: 

COLORS Click either of the color squares to make it active and 
edit the color using the RGB slide bars. 

For three-dimensional textures, you can edit both size and colors: 
 

 
You can edit the properties of the texture using the TEXTURE dialog box SIZE tab, 
see Editing Texture and Size Orientation, earlier in this chapter. 

 
You can edit color using the TEXTURE dialog box 3D tab. 
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SCALE Density of the pattern in the xyz directions (lower 
values give denser patterns). 

CONTOUR VALUES Numerical steps at which colors are defined. You 
may type any number between 0 and 1 on each line, 
using up to five successive lines. The numbers must 
be in ascending sequence. Changing the contour 
values changes the spacing of colors in the texture. 
Adding additional contour values introduces a larger 
variety of colors in the texture. 

COLORS Five color values defined for each contour value. 
These colors, including a continuous range of colors 
between them, are displayed in the texture. To 
change the colors in the texture, click any of the color 
squares and adjust the RGB slide bars. 

 NOTE   For the mathematically inclined: A three-dimensional texture is computed as 
contour surfaces of a function f (x,y,z), whose values range from 0 to 1. For specific 
contour values, you define colors in the dialog box. ARC+ Render Pro interpolates colors 
between the contour values that you define. 

Editing texture colors depends on the type of texture, and might vary for 
different types. 
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Bump Map Option-Roughening the Surface Appearance 
You can apply a texture as a bump map, which is a roughness (embossed 
appearance, variation of surface orientation) that is applied to a surface. Select 
the MISC tab in the TEXTURE dialog box. 

BUMP MAP DROP DOWN MENU 

NO BUMP Apply the texture smoothly. The texture hides any 
color that is applied to the same surface. 

JUST BUMP Apply the roughness effect to a surface, but not the 
colored texture from which it is derived. The 
roughness does not hide an underlying color, if you 
apply both the texture and a color to the surface, both 
show through. 

TEXTURE + BUMP Apply both the colored texture and the roughness 
effect. The texture hides any underlying color. 

 

Transparency Map Option-Textures with Transparent Holes 
You can apply a texture with transparency map that allow the background to 
show through. Common transparency map is invisible black pixels.  A black pixel is 
defined as any point in the texture pattern unit that contains pure black color 
(RGB = 0 0 0). In effect, the black pixels are transparent holes or windows in the 
texture. 

Check TRANSPARENCYMAP in the TEXTURE dialog box. 
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Transparency map options: 

TRANSPARENCY CHANNEL Use transparency channel for transparency map. This 
option is effective when texture file have alpha 
channel. If alpha channel is not available in the 
current texture file, the comment “no alpha channel” 
is displayed next to this option. 

COLOR RANGE Use the parts of the texture image with color range as 
transparent areas. Default color range is black. When 
color range is black (invisible black pixels), use the 
black (RGB 0 0 0) parts of the texture image as 
transparent areas. 

FILE Transparency map is available in external mask file. 

 

 

To create a texture where INVISIBLE BLACK PIXELS is selected by default, see Adding 
textures and texture categories, later in this chapter. You can override the default 
by deselecting INVISIBLE BLACK PIXELS in the TEXTURE dialog box. 

If the effect of the invisible black pixel doesn’t show in the rendered image, 
choose the ray tracing viewing method.  
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Effect on Computation Time 
Some three-dimensional textures take longer to draw on the screen than two-
dimensional textures. The time for a rendering computation may be increased 
when a three-dimensional texture is employed. 

 

 

Smoothing 

You can assign the smoothing attribute to solid entities. Smoothing is performed 
by averaging the light characteristics on the surfaces adjoining at an edge. 

Smoothing is effective, for example, to round the edges of a curved body that 
was approximated in ARC+ as a series of flat surfaces.  

You cannot smooth a polygon entity or a single polygon on the surface of a solid. 

 IMPORTANT   Smoothing is effective only if you choose the Phong or ray tracing 
option when you form the rendered image (see Chapter 5, Rendering, Shading options). 
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Defining a Smoothing Angle 
To assign a smoothing attribute, double-click on the solid entity, or right-click 
the mouse and select PROPERTIES. 

Specify the smoothing as an 
angle, greater than 0° and 
less than 180°. Smoothing is 
applied to any edge where 
the dihedral angle is greater 
than the value you specify. 

Thus a larger number of 
edges are smoothed if you 
specify a smaller smoothing 
angle. If you specify a 
smoothing angle of 0°, no 
smoothing performed. 

Default Smoothing 
If you do not assign a smoothing attribute to an entity, then smoothing is not 
performed. 

 

 

Billboards 

Billboards are objects that always face the camera.  For example, a flat object 
consisting of a simple polygon and a transparent texture (e.g. texture of a tree) 
can be defined as a billboard. Once an object is defined as a billboard, it will be 
automatically rotated towards the camera each time the camera is moved.  

 

This feature is especially useful when placing objects such as trees and people in 
an architectural scene. When the cameras on the scene are moved around, 
Billboards automatically rotate towards each rendered camera – a time 
consuming task when done manually. 
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Defining Billboards 
To define an object as a Billboard, right-click on an object and select Properties 

from the contextual menu. In the dialog box that opens, select the Billboard tab 

and check the Set Billboard box. 

 

 

Side Defines the object-side facing the camera (front, left, 
right, top, etc.). 

Center Defines the orientation of the selected object-side 
towards the camera (center, top-right, top-left, 
bottom-right, bottom-left etc.). 

Angle Defines the angle with which the object will be facing 
the camera. 

 



  Attributes 

ARC+ Render Pro User's Guide  2-23 

Assigning Attributes to Entities 

Polygons, Solids, and Walls 

You can assign attributes to polygon and solid entities in your model. If you 
assign an attribute to a polygon and later expand that polygon to a solid (see 
Polygons and solids, Expanding a polygon into a solid, \p3d command, in the ARC+ 
User's Guide), the solid is automatically assigned the same attributes as the 
polygon. 

When you assign an attribute to a polygon, the entire surface of the polygon is 
rendered with that attribute. 

When you assign an attribute to a solid, all surfaces of the solid are rendered 
with that attribute. You can override this and render one or more polygon 
surfaces of the solid with different attributes, by assigning different attribute 
values to those polygons. 

Remember that the two bases of a simple solid are polygons and you can assign 
attributes to the entire solid or to the bases alone.  

The sides connecting the bases of a simple solid are not polygons. You cannot 
assign attributes to one of these sides alone unless you draw a polygon over it. 

There are two exceptions to these rules: 

� The smoothing attribute can be assigned to solids only. You cannot smooth a 
single polygon surface. 

� If you apply a two-dimensional texture globally to a simple or rotational 
solid, it covers the sides but not the bases of the solid. To cover the bases as 
well, assign the texture separately to the base polygons or apply the texture 
nonglobally (see Textures earlier in this chapter). 

Be sure to assign attributes to all entities that will be displayed in the rendered 
image. For example, assign attributes to three-dimensional wall solids. There is 
little purpose in assigning attributes to two-dimensional wall bases, however, 
since these are not usually visible in the image. 

The Modeling and Rendering Modes 

You can assign attributes in either the modeling mode or the rendering mode. 
The differences between these modes are summarized in the following table: 
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 In the Modeling Mode In the Rendering Mode 
Enter: Individual commands for each attribute One command 
You can assign: 
 

Color, material, texture, or smoothing (one at a 
time) 

Color, material, and texture (all at once if 
desired) 

Assign attributes to: Individual entities or a selection group of 
entities 

Individual entities 
 

Indicate entities by: Pointing to an edge (e.g., a vertical edge of a 
wall) 

Pointing to any point on a visible surface of 
the entity or right-clicking its name in the 
scene tree and selecting PROPERTIES. 

The attribute is 
assigned: 

Immediately 
 

Immediately 
 

At the same time, you 
can set: 

 

 Lights 
Ambient light 
Background 

You see the result: When you form the rendered image 
 

Immediately (preview with no shading or 
Phong shading) 

You may mix attribute 
assignments with: 

Any other ARC+ command 
 

ARC+ Render Pro commands only 
 

Assigning Attributes in the Rendering Mode 
To enter the rendering mode, choose the following command: 
 
\grdyned 
 
 

Attributes 
Dynamic Editing 
 

 
The model is displayed in the work windows. Use the VIEW menu and the draw 
toolbar to adjust the view as desired (see Chapter 1.Getting Started, Windows and 
viewing icons). 

Assigning the Attributes 
To assign an attribute: click on the solid entity, right-click the mouse and select 
PROPERTIES. Double-click the blank rectangle you want to edit. 

To attach attributes, use the attach icons reviewed in Chapter 1, Getting Started, or 
Select Edit > Attach Mode from the menu bar and then select from the same 
menu choices as available in the icons below. 

 
From left to right: Attach to entity.  Attach to solid. 
Layers.  Colors. 

Click Attach to entity or Attach to solid icon and double-click the entity to open 
the Entity Properties dialog box and assign attribute.  To attach to a layer or 
color click the appropriate icon to open a layers or color properties dialog box.  If 
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you choose ATTACH TO SOLID, also specify how to wrap two-dimensional textures 
around simple solids (see Textures, earlier in this chapter): 

Attaching an attribute (texture, materials or color) is referred to as a 'look'. 

 IMPORTANT   The indicated point on the surface must be visible, not hidden behind 
any other entity. If no point on the desired surface is visible, rotate the model using the 
viewing icons until the surface comes into view. 

 

To assign an attribute, click 
on the solid entity, right-click 
the mouse and select 
PROPERTIES. 

 

You can either assign an 
existing attribute or generate 
a new one, for each one of 
the displayed rectangles. To 
assign an existing attribute 
(color, material or texture), 

select it from the relevant toolbar, drag and drop it on the rectangle. To generate 
a new attribute, double-click the rectangle you want to edit. An attribute setting 
dialog box is opened. 
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Use all the editing options as explained in Editing a Material earlier in this 
chapter (or other attributes).  

Saving an Edited Attribute 
Click APPLY, AUTO APPLY or OK. A SAVE AS dialog box opens. Specify a name and 
click OK to add the modified texture to the rendering files. 

 NOTE   If you create a new attribute definition by editing a predetermined attribute, 
you will be asked to give it a subname.  

When you check AUTO APPLY, all changes are dynamically applied to the 
displayed model, along with the editing. When you click APPLY, the changes are 
applied when you click, and the dialog box remains open. When you click OK, 
the changes are applied and the dialog box is closed. 

Placed Objects 
You can assign attributes to the component entities of placed objects within your 
model. 

When you do this, the attributes are stored in the source (library) file of the 
placed object. Thereafter, the placed object has the same rendering attributes in 
every model in which it is placed (unless you cancel or change the attribute 
values). 

To avoid this, copy the source file to your working directory and place the copy 
in your model. When you save the model, the copy file is modified but the 
source file remains unchanged. For information on copying library files 
automatically, see Chapter 1, Getting Started, Model and Rendering Files. 

Positive and Negative Solids 
You can assign attributes to both positive (ordinary) solids and to negative solids 
(openings and voids). When you do this: 

� A positive solid is rendered as you would expect-the attributes you assign 
are displayed on all surfaces. 

� A negative solid is rendered as an open area in your model-for example a 
doorway or window. 

� The attributes you assign to a negative solid are displayed at the boundary of 
the negative solid with a surrounding positive solid-for example a doorframe 
or windowsill. 
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Previewing the Rendered Image 
You can view the effect of your attribute assignments on the rendered image at 
any time.  Select one of the VIEW menu options or one of the icons at the draw 
toolbar: 

 
WIRE FRAME  View only the polygons forming the model (the 

default display).  Your model is displayed as in the 
modeling mode of ARC+. 

 
NO SHADING  View the rendered model without shading effects 

also known as FLAT RENDERING.  The true colors and 
textures of your model are displayed, exactly as they 
would appear in white ambient (uniform and non-
directional) light. Your lighting scheme is ignored in 
this option, and the effects of material attributes are 
not displayed. 

 
DYNAMIC RENDERING View rendered model with lighting and shadow 

effects, defined during dynamic rendering. Display 
the rendered image with the Phong shading option. 
You can observe the effects of your lighting scheme 
and of your color, material, and texture assignments. 
In order to save computation time, however, the 
quality of the image is lower than that of a DYNAMIC 
EDITING produced in the Rendering the model 
(\grender) command (see Chapter 5, Rendering). 

 
RAY TRACE View the rendered image with the ray-tracing option 
WHOLE WINDOW You can also preview a portion of the model using 

the RAY TRACING method.  Use this option, for 
example, to preview a region of the model to which 
you have assigned a transparent or reflective material 
attribute. 

 
RAY TRACE BY RECTANGLE In the VIEW menu, select ray tracing by rectangle. 

Then drag the mouse to define a fence (rectangle) in 
the model. The area within the fence is displayed 
using the ray tracing method. The display returns to 
the normal preview method if you assign a new 
attribute value to an entity within the fence or if you 
click a different preview icon. 
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RAY TRACE PUZZLE Depending on the complexity of your image and 

other factors, it may take a little time for a preview to 
be drawn on the screen. You can halt the screen 
redraw at any time by pressing Alt+Shift. This has no 
effect on your attribute, lighting, or background 
assignments. You can choose a different preview 
icon, or you can continue making attribute 
assignments. 

Customizing the Previewing Method 
You can customize certain aspects of the preview display using the following 
command: 

\grstde 
 
 

Tools 
Options 
Dynamic 

Using the dialog box, you may specify: 

SHADING QUALITY A parameter influencing the quality of the DYNAMIC 
RENDERING image. Choose higher values for a higher 
quality image, or lower values to save computation 
time (range 1-10, default 8). 

SHADOWS You can save time by turning SHADOWS EFFECT off. If 
you do this, ARC+ Render Pro does not check whether 
a surface of your model is shaded from a light source 
by other surfaces in your model. Therefore all 
shadows are eliminated from the preview image 
(default on). 

HIGH QUALITY Produces the highest quality preview rendering, or 
turn it off to save time. 
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Click the default button 
to return to default 
settings. 

Your image size setting 
takes effect only when 
you re-enter the 
Assigning attributes in the 
rendering mode (\grdyned) 
command. The other 
settings take effect 
immediately. 

You can change your 
settings at any time. 
ARC+ Render Pro 
remembers your latest 
choices, so they remain 
in effect even in your 
next ARC+ session. 

 NOTE   These settings affect only the preview display. To set the size and quality of the 
final rendered image, see Chapter 5, Rendering. 

Changing, Querying, and Editing an Attribute Value 
To change an attribute previously assigned to an entity, then simply reassign it.  
To cancel an attribute, enter the value none at the appropriate command prompt. 

You may also query an entity to determine assigned attributes. You may edit an 
attribute that you have already assigned, by: 

� Changing the RGB color combination 
� Changing the optical properties of a material 
� Changing the scale, orientation, colors, etc., of textures 
When you edit a material or texture attribute, you give the modified attribute a 
new subname and save it in the rendering files. This allows you to create new 
materials and textures and apply them to entities in your model. 

In the Modeling Mode 
Use the INQUIRE and EDIT commands that appear in the ATTRIBUTES pull-down 
menus (see Commands in the modeling mode, later in this chapter). 
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In the Rendering Mode 
Enter the rendering mode, select an attribute, right-click the mouse and select 
PROPERTIES. See above Assigning attributes in the rendering mode. 

If you wish to query or edit an attribute, point to any visible surface of the entity, 
right-click the mouse and select PROPERTIES. 

Setting the Background 
In the rendering mode, you can assign a background to your rendering in the 
same way as you assign attributes to entities. The background may be any color 
or most two-dimensional textures (see Chapter 4, Lighting, Background). 

To assign the background, select a color or a texture from the relevant tool bar, 
drag and drop it on the background. 

If you wish to change the background, simply assign another color or texture to 
it. You cannot clear the background completely, since every rendering must have 
a background. 

 NOTE   You may also assign the background using the SETTING THE BACKGROUND 
(\grbckgrd) command, in either the modeling or rendering mode (see Chapter 4, 
Lighting). 

Color Mapping Table 

You can color-code the entities of your ARC+ model using the fifteen standard 
ARC+ colors. For example, you could use color 1 for brick walls, color 2 for glass 
window panes, color 3 for metallic surfaces, etc. 

Then, you can construct a color-mapping table to translate the standard ARC+ 
colors into color, material, and texture rendering attributes. In this way you map 
color 1 to a brick texture with chalk-like optical properties, color 2 to a transparent 
glass material with white color, color 3 to a coppery color with aluminum-like 
reflectance, etc. 

If you wish to override the color mapping for one or more entities in your 
model, then simply assign different attribute values to those particular entities. 

To override, double-click a color in the scene tree. Drag and drop attributes from 
the color, texture and material bars into the attributes dialog box. You can edit 
and save these attributes by double-clicking the selected rectangle. 
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Layer Mapping Tool 

You can automatically map the layers of ARC+ onto color, material, and/or 
texture attributes of your choice. For example, you can assign a red color and 
glass material attribute to all entities in layer 1, or a chalk material and carpet 
texture to all entities in layer 2. 

To map the layers, double-click on a layer in the scene tree. Drag and drop 
attributes from the color, texture and material bars into the attributes dialog box. 
You can edit and save these attributes by double-clicking the selected rectangle. 

Viewing Attributes 

To view a complete list of entity attributes, select Show extended entity attribute 
page in the Options dialog box, Attribute tab.  Then double-click the entity to 
open the entity properties dialog box.  Here you can view the solid, layer and 
color fields of an entity.  This extended viewing is valuable in working with 

Attaching attributes 
discussed earlier 
and Combining 
Attributes discussed 
below. 
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SHOW EXTENDED ENTITY 
ATTRIBUTE PAGE 
(VERIFY) 

Enable view of extended entity attribute page or 
reduce icon size. 

SUB ATTRIBUTES Enable selection of attribute by subname. 

SCENE TREE VIEW Enable exploring attributes in scene tree view. 

DEFAULT Click to return to default settings. 

 

 

Combining Attributes 

You can combine attributes to represent a great variety of construction materials 
and finishes. 

For example, a "colorless" glass window pane can be represented with a white 
color attribute and a material with high transparency and low reflectance. The 
window can be converted to colored glass by giving it a nonwhite color while 
leaving the material attribute unchanged. 
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In the event of conflicts between attribute values assigned in different ways to 
the same entity, the following order of precedence (from highest to lowest) is 
employed: 

� Polygon entity 
� Solid entity 
� Layer mapping tool 
� Color mapping table 
� Default attribute value 

For example, suppose you have created several solid entities in your model, each 
with the standard ARC+ color 1. Assign a marble texture to one face of a single 
solid, a wood texture to the rest of the solid, map a brick texture onto the other 
solids using the color mapping table. 

 NOTE  Remember that textures override colors. If you assign both a texture and a color 
to an entity, the texture is rendered and the color is ignored (see Textures, earlier in this 
chapter). 

Creating and Previewing a Lighting Scheme 

You can create or edit a lighting scheme while you assign attributes in the 
rendering mode. If you choose the DYNAMIC EDITING option from the attributes 
menu, you see the effect of your lighting scheme immediately on the rendered 
image. 

Create or Edit Light Sources 
 
 
 
 

Lights 
Graphic Editing 
 

 
Light-editing windows and a dialog area are displayed. Select and drag the light 
and target symbols with the mouse or enter options and numerical parameters 
in the dialog area. Click SAVE or SAVE AS to save the light in the rendering files. 
For further information on light definitions, see Chapter 3, Lighting, Defining the 
location and type of lights (\grlight) command. 
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Commands in the Modeling Mode 
In the modeling mode, you must enter a separate command to assign or edit 
each attribute. In the rendering mode, the attributes are assigned interactively in 
a single operation, and the following commands are not needed (see Assigning 
attributes in the rendering mode, earlier in this chapter, \grdyned command). 

Assigning and Editing Color, Material, or Texture 

To assign and edit entities use the identical operating method described below. 

Assigning:  Polygon Entities 
 
\catrib 
\matrib, 
\tatrib 

Attributes 
Dynamic Editing 
Set Color/Material/Texture 

 

Assigning: Solid Entities 
 
\scatrib, 
\smatrib, 
\statrib 

Attributes 
Dynamic Editing 
Set Color/Material/Texture 

Editing: Polygon Entities 
 
\greclr, 
\gremat, 
\gretxt 

Attributes 
Polygon Attributes 
Edit Color/Material/Texture 

 

Editing: Solid Entities 
 
\gresclr, 
\gresmat, 
\grestxt 

Attributes 
Solid Attributes 
Set Color/Material/Texture 

 

Operating Method  
Double-click the entity to open the Entity Properties dialog box and open the 
Attribute tab to view current attributes.  Select textures or basic elements (such 
as glass, mirrors, etc.) from the selection window located to the right of your 
work window. 
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Select attribute (texture, material and color) and drag it to the appropriate field 
in the dialog box.   

To delete an existing attribute value, select it in the dialog box and click the 
delete button on your keyboard. 

If you are assigning a texture attribute, choose solid mapping (global wrapping 
around sides) or single mapping (applied individually to each surface). 

 NOTE   This option is effective only if you are assigning a two-dimensional texture to a 
simple solid or to certain rotational solids (see Textures, earlier in this chapter). With 
three-dimensional textures or other types of solids, this option is ignored. 

Selection 
Windows 
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Smoothing a Solid 

Assign a smoothing attribute value to a solid entity. 
 
\grsmth 
 
 

 

 
Select the Solid tab in the Entity Properties dialog box, click Smooth. 

Specify the smoothing as an angle, greater than 0� and less than 180�. Smoothing 
is applied to any edge where the dihedral angle is greater than value specified. A 
larger number of edges are smoothed if you specify a smaller smoothing angle. If 
you specify a smoothing angle of 0�, however, then smoothing is not performed. 

Indicate the solid entity to be smoothed. 

 IMPORTANT   Smoothing is effective only if you choose the Phong or ray tracing 
option when you form the rendered image (see Chapter 5, Rendering, Shading options). 

Modifying a Look 

To modify the look of colors, materials and textures, select the attribute in the 
Attribute tab of the Entity Properties dialog box, as discussed above.  The Look 
editor toolbar is now activated.  This toolbar is reviewed in Chapter 1, Getting 
Started.   

 
From left to right: Move texture left.  Move texture right.  Move texture up.  
Move texture down.  Rotate texture left.  Rotate texture right.  Decrease texture 
scale X.  Increase texture scale X.  Decrease texture scale Y.  Increase texture scale 
Y.  Increase blending.  Decrease blending. 

Click icon as desired to move, rotate, increase and decrease textures and blend 
colors. 
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Editing the Libraries 
The Libraries can be customized in a number of ways: folders and subfolders can 
be added, and rendering attributes can be added up and edited (Library is a 
collection of rendering attributes such as textures, materials and colors). 

Editing Rendering Attributes 

The powerful library tools allow editing, adding, or deleting rendering attributes 
such as textures, materials and colors. 

 
To delete a texture  Right click on the 

texture in the library 
bar and select Delete. 

To edit a texture Double click on a 
texture, or right-click 
on it and select 
Properties. A dialog 
opens in which you 
can edit various 
attribute parameters. 

To add a new texture Right click on the 
library bar and select 
New, or select File > 
Import-Texture from 
the menu bar. In the 
import dialog box you 
can specify the library 
and category in which 
you want the new 
texture to be stored 
(see Importing New 
Textures).  

To copy a texture Copy the texture from 
the scene, and paste it into the library bar. 

To duplicate a texture  copy the texture from the library bar and then paste it 
again. 
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 Note: Read-only libraries cannot be edited. System 
libraries are read-only by default. 

 

Custom Procedural Textures 

Custom procedural textures can be added to ARC+ Render Pro.  Sample 
procedural textures (shaders) such as Gradients, Checkers, and Strips are 
available in the User textures library. These procedural textures can be created 
using the Plug-ins development kit. The ARC+ Render Pro Plug-in Development 
Kit (PDK) allows third party developers to extend ARC+ Render Pro and create 
custom textures.  
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Importing New Textures to ARC+ Render Pro 
Use the ARC+ Render Pro import texture command to add an unlimited number 
of new two-dimensional textures to the rendering library.  

Creating a Texture 
Each two-dimensional texture is defined by a bitmap file, which contains the 
repeating unit (pattern motif) of the texture. You can create the bitmap in any 
number of ways, for example: 

� By drawing a motif with a graphics program 
� By scanning a photograph or hand drawing 
� By producing an image file using ARC+ Render Pro 
� By editing a bitmap produced by any other method using image processing 

software 

The bitmap size is only limited to the memory available in your computer. Many 
of the predefined two-dimensional textures supplied with ARC+ Render Pro, for 
example, have a bitmap size of about 200 x 200 pixels. You can create the bitmap 
in either a 256 color format (8-bit color) or an RGB format (24-bit color). 

Optionally, you can create a texture that contains transparent areas, where the 
background shows through. To do this, color the desired transparent areas black 
(RGB = 0 0 0). This allows you to apply the texture with the TRANSPARENT PIXELS 
option (see Textures, earlier in this chapter), which produces the transparent 
effect. 

Store the bitmap in one of the following file types: BMP, TIFF, TGA, PCX, GIF, or 
JPEG. For further information on the supported file types, see Forming the image, 
Image file types. 

Save your bitmap files as you wish to display them. For example, if you name a 
file REDBRICK.TIF, the texture will be displayed under the name redbrick in the 
ARC+ Render Pro dialog boxes. 

Importing Textures  
In ARC+ Render Pro, textures have both a category and a name. You can add new 
textures to existing or new categories. 
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 NOTE   To avoid potential conflicts between your textures and textures provided with 
ARC+ Render Pro, it is recommended to add textures only to categories that you define 
yourself, not to the predefined categories supplied with ARC+ Render Pro. 

To Import Textures 
To import bitmap textures (see Creating a texture) into the library, run the 
following command: 

 
 
 

File 
Import Texture 
 

 
 

The IMPORT 
TEXTURE dialog box 
is opened. 
  
Select the file (or 
files) you want to 
import.  
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In the dialog box, specify the following options: 

FILE NAME Defines the new file name. 

TYPE Defines the new file type. 

LIBRARY The library name. 

CATEGORY The library folder where the textures bitmaps are 
stored. You can use an existing category or create a 
new one. 

TRANSPARENT PIXEL Allows you to apply transparency to a specified color. 
Check the box and double-click on the color box next 
top it to select a color. 

Defines areas with specified color (default black RGB 
= 0 0 0) of the texture bitmaps as transparent areas, 
where the background can show through.  

This option sets TRANSPARENT PIXELS as the default for 
the texture. You can override the default when you 
apply the texture (see Textures, earlier in this chapter).

KEEP BITMAP ASPECT 
RATIO 

The icon is created with Bitmap aspect ratio. 

The new textures are displayed in the ARC+ Render Pro library bar, ready for 
your use. 

If You Install a New Version of ARC+ Render Pro 
If you imported textures into the standard textures library, back up your texture 
bitmap files to another folder (not a subfolder of ARC+ Render Pro), before you 
install a new version of ARC+ Render Pro. Then install the new version of ARC+ 
Render Pro, and (if necessary) import again your textures in the new version.  
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CamerasCamerasCamerasCameras    

 
Before rendering the model, define the camera or cameras of the rendered 
image.  These cameras are the viewing points, the direction and perspective from 
which the model is observed.  Each model contains five default cameras: 
perspective, north, south, east and west. You can modify the default cameras or 
create new cameras using the Camera Wizard. 

It is important to keep in mind that the term camera has replaced the term view, 
used in earlier versions of ARC+ Render Pro. 

Working With Cameras 
Select Cameras > Graphic Editing. 

3
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The current or default view of your model, seen from the angle of the default 
camera, is displayed in the axonometric window at the upper left of this screen. 
This is the active camera. 

The remaining two work windows are camera control windows and work exactly 
like the view control windows in the modeling mode. Here you can change the 
view (from the camera's angle) by dragging the eye and target symbols or the 
line between them (see Viewing, Using the control windows in the ARC+ User's 
Guide). 

The Camera Wizard 
 
\greview 
 
 

 

 
Select Edit > New from the menu bar, or right-click on any of the work windows 
and select New from the menu to open the NEW dialog box.   

This dialog box is used to 
create cameras (this chapter), 
light (see Chapter 4, Lighting), 
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paths (see Chapter 6, Animation).   

The camera wizard contains a list of camera choices, as well as exterior or 
interior settings.  Select camera and setting and click OK. 

The new camera is displayed graphically in both camera control windows.  The 
camera setting is displayed in the active axonometric window. 

 NOTE  The active camera is represented with an additional box in its target line. 

 

Setting the Cameras in the Rendering 
Mode 

You have two options in setting the cameras: 

� Set the camera in the modeling mode using ARC+ control windows and 
commands (see Viewing, Setting the projection in the ARC+ User's Guide). 

� Set the camera using ARC+ Render Pro menu, camera icons, and dialog 
boxes provided in the rendering mode.  (This is the option discussed in this 
chapter.) 

In either option, you must adjust the camera on the screen and then set the 
camera using an ARC+ Render Pro command.  You can set the camera at any 
time. Once set, the camera is stored in the rendering files and used when you 
produce the rendered image. 

 NOTE   An additional factor affecting the rendering camera setting is the ratio of height 
to width of the image file (see Chapter 5, Rendering, Image file types). 

If you work in the rendering mode, you can set several different cameras and 
choose which one to use for each rendering. Use this feature, for example, to 
create a series of renderings that show your design from different perspectives.  

Each camera is saved under a name that you specify. Keep in mind that the 
current camera is called the active camera. 

Set one or more cameras for rendering using the dynamic editing mode. 

\greview 
 
 

Cameras 
Graphic Editing 

 
\greview 
 
 

Attributes 
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The ARC+ RENDER PRO screen is displayed (see Chapter 1, Getting Started for a 
detailed explanation of all the screen components). 

Camera Control Windows 
Select one of the camera icons (by clicking its icon in one of the CAMERA CONTROL 
WINDOWS) and drag the eye and target symbols with the mouse. 

� If you wish to change the direction or perspective of the camera, drag the eye 
or target symbol alone. 

� If you wish to pan the camera, drag the line between the eye and target. 

In either case, the changes you have made are reflected in the axonometric 
window, as well as in the parameter values of the CAMERA PROPERTIES dialog box 
(if displayed).  

Changing Camera Settings 
To control the properties of a camera, choose one of the following three options 
to open the CAMERA PROPERTIES dialog box: 
Double-click its name in the scene tree, or right-click its name in the scene tree 
and select PROPERTIES, or right-click the camera icon in one of the camera control 
windows and select PROPERTIES. 
 

  
Select the GEOMETRY tab.  
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Camera Properties Dialog Box 
In the dialog box you can set the following options: 

EYE The coordinates of the observer's eye in three-
dimensional space. This can be at any point in the 
exterior or interior of the model. 

TARGET The center of the observer's cone of view. 

PARALLEL/PERSPECTIVE Set a parallel or perspective camera. 

PCONE The angle (breadth) of the perspective cone from the 
observer's eye. Set a narrower angle to restrict the 
camera to a limited area of the model. 

PAN Move the center of the rendered image by a specified 
distance in the x or y direction. 

ZOOM Expand a section of the cone viewed by the camera 
(centered about the pan coordinates) to fill the 
rendered image. Set equal values of the x and y zoom 
factors to enlarge a square area of the target area, or 
unequal values to enlarge a rectangular area. 

 NOTE   For a detailed explanation of these parameters, see Viewing, Setting the 
projection in the ARC+ User's Guide. 

The effect of the changed parameters is immediately displayed in the 
axonometric window. If you change the EYE, TARGET, or PCONE parameters, the 
changes are reflected in the camera control windows as well. 

Saving a Camera Setting 
Every change in the setting of the selected camera (like any other object) is 
automatically saved, as part of the rendering files. If you do not want to apply 
the change, use EDIT > 
UNDO from the menu. 

To add a camera, in the 
scene tree, copy an 
existing camera and 
paste it in the tree.  

To customize the name of 
a camera, from the same 
menu, select RENAME.  
A RENAME dialog box is 
opened.  
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You can either select the default name ($CURVIEW) or the names already attached 
to your model, or type a new name of your choice. 

You may save any number of camera settings under different names.  

Selecting an Active Camera for Production 
In the production mode, used to preview your 
work, you can select one of the camera settings 
that you saved as the active camera. When you 
render an image / animation of the model, the 
camera used will be that of the selected active 
camera. 

Select the name of the required camera in the 
SCENE TREE and right-click the mouse.  

A pop-up menu is opened: 

 

Select SET ACTIVE.  Keep in mind that during 
rendering or animation you can change the 
camera desired. 

Setting Camera View Option  

Right-click in any 
camera control 
window to open the 
VIEW OPTIONS dialog 
box, camera tab. 

 

 

 

 

 

 

Selected Camera Show the selected (current) camera in the camera 
control windows. 

All Cameras Show all cameras in the camera control windows. 
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LightingLightingLightingLighting    

Working with Lighting 
Lighting enhances the 3D appearance of your images with highlights and 
shadows. In addition, ARC+ Render Pro offers the opportunity to create lighting 
animation. Lighting animation enables you to move and change lighting types 
within a static scene, as well as illuminate a walk-through animated scene.  
Lighting animation is fully discussed in Chapter 7. 

In ARC+ Render Pro, you can define several types of illumination: 
POINT  A light source, such as an interior lamp, that radiates 

with uniform intensity in all directions from a 
specified point. 

SPOT A light source that radiates in a cone-shape, from a 
specified point. You can define the angle of the cone 
and the variation of light intensity within the cone 
angle. 

DISTANT  A distant source of light that casts parallel rays on all 
parts of the model. The location of the light source is 
specified and used to determine the direction of the 
light rays.  

SUN  A distant source of light that simulate sunlight for 
shadow studies based on global position, date and 
time. 

AMBIENT LIGHT Uniform, non-directional light that illuminates all 
parts of the model, without regard to direction or 
shading. 

You can define as many point, spot, or distant lights as you want, as well as 
ambient light. You can store the light definitions in the rendering files and turn 
individual lights on or off. This enables you to activate lights selectively to 
produce renderings at different times of day or night. 

4
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In addition, you can simulate atmospheric conditions and the surroundings of 
your model by defining: 
FOG Haze that blurs parts of the model that are more 

distant from the observer's eye. 
BACKGROUND Color or texture behind your model. 

To set the lighting parameters, use commands on the LIGHTS menu or the LIGHT 
PROPERTIES dialog box. Alternatively, you can activate the light setting mode 
from the ATTRIBUTES menu (see Chapter 2, Attributes).  

Defining the Location and Type of Lights 
Define the location and direction of point, spot, and distant light sources. 
 
\grlight 
 
 

Lights 
Lights layout 

  
The ARC+ RENDER PRO screen is displayed.  
 

 
The current or default view of your model is displayed in the axonometric 
window. The two light control windows contain the symbols for the light sources 
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and targets. You can change the views in each window using the VIEW menu (see 
Chapter 1, Getting started, Windows and viewing icons). 

Working with Work Light 
A light source called Work Light, located at the observer's eye position, is 
automatically defined for every ARC+ model. By default, work light is a point 
source with a white color.  

Defined as a cone or distant source, work light is always aimed at the target 
(center of focus) of the rendering view. If you move the eye or target, work light 
moves as well.  You can freeze the position of the light source before moving the 
eye or target, save a copy of work light under another name. You cannot delete 
work light, but you can turn it off and alter its properties. 

 NOTE   By default, WORK LIGHT is turned on for models that you are rendering for the 
first time. 

The Lighting Wizard 
 
\ 
 
 

Lights 
Lights Layout 

 
Select Lights > Lights Layout, then Select Edit > New from the menu bar or 
right-click on any of the work windows and select New from the menu to open 
the NEW dialog box.   

This dialog box is used to create lights (this chapter), cameras (see Chapter 3, 
Cameras), paths (see Chapter 6, Animation).   
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The light wizard contains a list of light choices, such as point, spot and distant, 
as well as exterior or interior settings.  Select light and setting and click ok. 

 
Point light  The light rays emanate from a 
single point. See below for full information 

Spotlight The light rays emanate from a single 
point.  See below for full information. 

 

Distant light  The light emanates from a point 
removed from the image.  See below for full 
information. 

Point, Spot, and Distant Light Sources 
For each light source define the location of the light. For spot and distant light 
sources, define the location of the light and a target point for the light. 

SOURCE  The xyz coordinates from which the light shines. 
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TARGET A point along a line from the light source, 
determining the direction of the parallel rays from a 
distant source, or the center of the cone from a 
spotlight. 

Define these points either by typing the coordinates in the LIGHT PROPERTIES 
dialog box or graphically by dragging the location and target on the screen with 
the mouse. 

You must also set the color of each light source: 

RGB The RGB color of the light (see Chapter 2, Attributes, 
Color Mapping). The color of an entity in the rendered 
image is a combination of the color attribute that you 
have assigned to the entity and the color of the light. 
For example, a light with a yellow color will impart a 
yellowish tinge to the model. 

 NOTE   The RGB concept of color includes intensity of the light. To weaken the 
intensity of a light, simply reduce the RGB component contributions. There is no need 
for a separate intensity parameter. 

You can determine: 

LIGHT ON The light source is on. If you turn the light off, the 
light source remains defined but is ignored in the 
rendering computation. You can turn the light back 
on at any time. 

SHADOWS EFFECT ARC+ Render Pro checks whether each surface in the 
model is shaded by any other surface from each light 
source. If you turn shadows off for a light source, 
then the source is considered to shine on all entities of 
the model, and ARC+ Render Pro does not check for 
shadows from that source. 

FADE By default, the light intensity is uniform at all 
distances from the light source. If you set a fade value 
that is larger than 0, the light decreases in intensity 
with distance from the source. The light fades more 
rapidly with larger values of this parameter (range 
0-2). 

Softening the Illumination 
For point and spot sources, the light rays are considered to emanate from a 
single point. This may produce relatively harsh illumination with sharp shadows. 
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If you choose the ray tracing option to produce your rendered image (see Chapter 
5, Rendering, Shading options), you can soften the illumination and produce 
fuzzier shadows by defining the following parameters: 

RADIUS The radius of a point or spot light source, considered 
as a sphere. 

RAY SAMPLE The number of points within the sphere from which 
light rays are considered to emanate. With a value of 
0, this feature is turned off and all the light emanates 
from a single point. With a value of 2 or more, the 
light intensity is divided between more than one 
point and the illumination is softened. 

These parameters are not applicable if you choose a shading option other than 
ray tracing. 
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Spotlights 
For a spotlight, define the size of the light cone: 

CONE ANGLE The angle of the light cone, for example, an angle of 
5� means that only a narrow cone illuminates the 
model. A larger angle causes the cone to widen and 
illuminate a larger area in the target direction. The 
maximum angle is 180�, illuminating a hemisphere of 
space. 

Optionally, you can alter the distribution of light within the cone by defining 
two additional parameters: 

BEAM DISTRIBUTION By default, the light intensity is uniform everywhere 
within the cone angle. If you set a value other than 0 
for beam distribution, the light has full intensity only 
at the center of the cone and fades to a lower intensity 
at the edges (range 0-50). 

CONE DELTA  The cone delta angle defines the sharpness of the cone 
edge. With an angle of 0�, no light falls outside the 
cone. With a larger angle, the light fades away 
beyond the cone edge. For example, a delta angle of 
10� means that there is absolutely no light from the 
spot source at 10� away from the cone (range 0-180�). 

Effect on Computation Time 
The time required for the rendering computation increases when a larger number 
of light sources are employed. Usually, you can produce an excellent rendering 
with about 2-3 light sources plus ambient light. The ambient light ensures that 
shaded areas do not appear completely black in the image. The fade, cone angle, 
beam distribution, and cone delta angle parameters have only an insignificant 
effect on computation time. 

The ray tracing option increases computation time, as a larger number of ray 
samples is defined for each light source. Usually, about 4 ray samples from each 
light source are sufficient for a good image. The radius value has no effect on 
computation time. 
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Setting Light Properties 
To control the properties of a light: 

Double-click its name in the SCENE TREE, or, right-click its name in the SCENE TREE 
and select PROPERTIES, or right-click the light icon in one of the light control 
windows. 

The LIGHT PROPERTIES GENERAL dialog box is opened. 

 
LIGHT TYPE Choose point, spot, or distant from the scroll box. 
LIGHT ON Check this box to turn the light source on. Remove 

the checkmark if you want to turn the light off. 

When selecting the Geometry tab, the LIGHT PROPERTIES GEOMETRY dialog box is 
opened. 

 
LIGHT SOURCE Enter the coordinates of the light source, or drag the 

source symbol in a model window with the mouse. 
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LIGHT TARGET (For spot and distant sources) Enter the coordinates of 
a point along a line from the light source, or drag the 
target symbol in a model window with the mouse. 

CONE ANGLE For spotlights, enter the desired breadth, sharpness, 
and uniformity of the light cone. 

When selecting the Attributes tab, the LIGHT PROPERTIES ATTRIBUTES dialog box is 
opened: 

 
R G B Adjust the RGB slide bars to the desired color of the 

light source. 
SHADOWS EFFECT Check this box if you want ARC+ Render Pro to 

check for shadows from the light source. 

When selecting the Advanced tab, the LIGHT PROPERTIES ADVANCED dialog box is 
opened: 
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FADE Adjust the slide bar or enter a numerical value to 
define the desired fading pattern of the light source. 

RADIUS (For spot and point sources and for ray tracing) Enter 
a numerical value for the radius of the light source. 

RAY SAMPLE (For spot and point sources and for ray tracing) Enter 
a numerical value for the number of points within the 
sphere of the light source. 

IRIS (For spot light). Adjust the slide bar or enter a 
numerical value (between 0-1) to define the size of 
the circle illuminated by the spot light.  

Naming Lights 
To customize the name of a light, select a light in 
the SCENE TREE and right-click the mouse. A pop-
up menu is opened: 

 

 

Select RENAME. 

A RENAME dialog box is opened: 

You can either select one of the default names or 
type a new name of your choice. 

 

Saving a Light Definition 
Every change in the setting of the selected light (like any other object) is 
automatically saved, as part of the rendering files. If you do not want to apply 
the change, use EDIT > UNDO from the menu. 

 NOTE   You can also define light sources from the ATTRIBUTES LIGHTS menu (see 
Chapter 2, Attributes, Creating and previewing a lighting scheme, \grdyned command). 
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Soft Shadows 

To create light with soft shadows: 

Right click on the light and then click Properties. In the Light Properties dialog, 
click Advanced. 

 
ENABLE SOFT SHADOWS Check to enable soft shadows. 
RADIUS (For spot and point sources and for ray tracing) Enter 

a numerical value for the radius of the light source. 
RAY SAMPLE (For spot and point sources and for ray tracing) Enter 

a numerical value for the number of points within the 
sphere of the light source. 

 NOTE   Use ray tracing to produce picture with soft shadows effect. Note that soft 
shadows may considerably affect calculation time. 

 

Turning Lights On and Off 

To turn light sources on or off, use one of the following ways: 

In the SCENE TREE window, select a light and right-click the mouse. In the menu 
that is opened click TURN LIGHT ON, or in the LIGHT PROPERTIES dialog box - 
GENERAL tab, click LIGHT ON. 
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Sun Light 
Sun light is a distant source of light that simulates sunlight for shadow studies 
based on global position, date and time. 

Insert Sun Light 
Select Edit > New from the menu bar or right-click on any of the work windows 
and select New from the menu to open the NEW dialog box.   

 

 
Click the + sign on the side of the LIGHT branch to open light options.  Select SUN 
LIGHT and setting and click NEW. 

The NEW SUN LIGHT dialog is displayed. 
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LATITUDE, LONGITUDE Global position on earth. Type latitude and longitude, 

or click the  button to select geographic location 
from list of cities around the world. 

TIME ZONE Select time zone from list of available time zones. 
DAYLIGHT SAVING Check if daylight saving is effective. 
DATE, TIME Specify the required date and time. 
 

Setting Geographic Location 

To select geographic location from list of cities around the world, click  
button in the NEW SUN LIGHT dialog or SUN LIGHT PROPERTIES dialog. Select 
geographic location, and click OK. 
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Setting Sun Light Properties 
To control the properties of sun light: 

Double-click its name in the SCENE TREE, or, right-click its name in the SCENE TREE 
and select PROPERTIES, or right-click the light icon in one of the light control 
windows. 

The LIGHT PROPERTIES dialog box is opened. 

When selecting the SUN tab, the LIGHT PROPERTIES SUN dialog box is opened. 
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The dialog is identical to the NEW SUN LIGHT dialog. You can change date and 
time, to simulates sunlight for shadow studies in different hours of day, and 
dates of the year. 

 

Ambient Light 
Ambient light is uniform, non-directional light of any RGB color. Ambient light 
illuminates all surfaces of your model equally, without regard for shadows or 
location of the surfaces. 

Use ambient light in addition to point, spot, or distant light sources to decrease 
the depth of shadows in your model. Ambient light ensures that all portions of 
your model receive some illumination, so that shadowed areas are not 
completely black. 

It is recommended to use a fairly low intensity of ambient light (i.e., low RGB 
component values). If the ambient light is too strong, the other light sources you 
have defined are likely to be washed out. 
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Setting Ambient Light 

Set the color of ambient light illuminating all portions of your model. 

\grlight 
 
 

Lights 
Ambient Light 
 

 
The RENDER PROPERTIES dialog box is opened: 

 
 

Adjust the RED, GREEN, BLUE slide 
bars until the desired ambient 
light color is displayed. 

 

 

Background 
Every rendering must have a background. The background includes everything 
appearing behind the model in the rendered image. 

The background may be a solid color or a two-dimensional texture. The 
background is copied exactly into the rendered image. The colors or textures in 
the background are not rendered or otherwise changed during the rendering 
process. 

Setting the Background 
Set the background color or texture of the model. 
 
\grbckgrd 
 
 

Lights 
Background 
 

 
A dialog box (similar to the one 
shown for ambient light) is 
opened. 
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Double click on the square: A color palette is opened. Adjust to your desirable 
color. 

Fog 
You can simulate atmospheric conditions by specifying fog in your rendering. 
Fog decreases the intensity of colors and gives objects in your image a hazy 
appearance. The effect increases with distance of the object from the observer's 
eye. 

To define fog, you must specify a fog distance and color: 

FACTOR A value of 0 turns this option off and the model is 
rendered without fog. A value other than 0 signifies 
the approximate distance at which entities in your 
model are obscured by the fog or the visibility 
distance. Thus, larger values mean less fog 
(default 0).  

COLOR The RGB color of the fog, which tints the colors in 
your rendering slightly. The degree of tint increases 
with distance from the observer's eye. 
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Setting the Fog Value and Color 

Set the degree and color of fog in your rendering. 
 
\grfog 
 
 

Lights 
Fog 
 

 
A dialog box (similar to the one shown for ambient light) is opened. 

 
Specify the fog FACTOR, and adjust the RED, GREEN, BLUE slide bars until the 
desired fog color is displayed. Set the fog factor to 0 if you wish to turn this 
option off and render the model without fog. 

Setting Light View Option  

Right-click in any light control window to open the VIEW OPTIONS dialog box, 
light tab. 
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SELECTED LIGHT Show only the selected (current) light in the light 

control windows. 

TURNED ON LIGHTS Show all the lights that are turned on, in the light 
control windows. 

ALL LIGHTS Show all lights in the light control windows, 
including the ones that are turned off. 

DRAW COLOR BEAMS Draw the light source and the light beams in their 
specified color. 
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RenderingRenderingRenderingRendering    

 
Images are the final products of rendering. ARC+ Render Pro provides several 
options by which you control the quality and type of the rendered image: 

IMAGE FILE TYPE The format and size of the image file that is created 
by ARC+ Render Pro. This determines image 
resolution (fineness of detail), completeness of color 
information stored in the file, and the suitability of 
the file if you wish to edit or print the image using 
other (non-ARC+) software. 

RENDERING QUALITY The level of sophistication at which ARC+ Render 
Pro computes the image. This determines the 
sharpness of shadows and highlights, smoothness of 
lines and of color gradations, and effects of 
transparency and reflections. 

RENDERING OR RAY 
TRACING METHOD 

In the rendering method, the effect of light falling 
directly on each surface of your model is computed. 
In the ray tracing method and in the Phong option of 
the rendering method, the effect of indirect 
illumination reflected from other surfaces or 
transmitted through transparent surfaces is computed 
as well. 

It is important to understand option results, as well as computation time 
consideration in order to obtain lifelike images.  

The rendering process can produce two types of scenes.  The techniques utilized 
in creating these scenes are described in detail in this guide and can be combined 
in any number of ways to create a truly life-like 3D scene. 

1. A rendered image, containing all the attributes (colors, textures and 
materials) included in your scene.  See Attributes, Chapter 2 for a complete 
explanation of working with scenes and attributes.   

5
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2. An animated scene.  ARC+ render Pro offers several types of animation: 
walk-through animation discussed in detail in Chapter 6, Walk-through 
Animation, lighting animation discussed in detail in Chapter 7, Lighting 
Animation, and objects animation discussed in detail in Chapter 9, Objects 
Animation.  These types of animation techniques can be combined in any 
number of ways to energize your scene. The rendering process can further 
be refined by defining the image quality and shading, as well as defining 
when the scene is to be rendered, immediately or at a later time.  All these 
capabilities are discussed in this chapter. 

3. A panoramic rendering.  Panoramas enable viewers to get a panoramic view 
of 3D designs, discussed in detail in Chapter 8, Panorama. 

Image File Types 
Computer images are composed of tiny dots, called pixels. Your computer 
display contains a fixed number of pixels, for example 800 x 600 or 1024 x 768 
pixels in the horizontal and vertical dimensions, respectively. 

ARC+ Render Pro images are rectangular, with the width and height specified in 
pixels. A larger image size fills a larger area of your screen and provides finer 
detail in your rendering. 

Each pixel in an image is displayed with a certain color value. This information 
is stored in the computer's memory and on your disk in an image file. 

You can choose to create the image file in various industry-standard formats, for 
example JPEG (JPEG File Interchange Format), TIFF (Tagged Image File Format), 
BMP (Windows bitmaps), or PCX (PC Paintbrush). Using this feature, you can 
create and view an image with ARC+ Render Pro and then transfer the image 
file to other programs, for example: 

� To a graphics or desktop publishing program for arrangement with other 
figures and with text 

� For output on a color or black-and-white printer 
� For color separation on automatic image setting equipment, prior to printing 

a brochure or book 

Some of the image file formats store true RGB color information (over 16 million 
colors) using 24 computer bits (3 bytes) to store the color of each pixel. Other 
formats store a maximum of 256 different colors using only 8 bits (1 byte) per 
pixel. 

The 24-bit formats give the most accurate color representation and the smoothest 
color gradations. An 8-bit format represents colors less accurately, but it 
produces smaller files that save space on your disk. 
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If you choose an 8-bit format, you may notice sharp boundaries between shades 
of colors, where no boundaries should exist. You can prevent this by producing 
the image with dithering, a computation method that varies the colors of 
individual pixels slightly and smoothes the color gradations. 

Some file formats also offer an option of file compression. Choose a compression 
option to make the image file smaller and save space on your disk. Compression 
has no effect on color accuracy or other aspects of your image data. 

 NOTE   The TGA file type offers two additional formats, using 16 or 32 bits to store each 
color, with intermediate and high color accuracy respectively. 

Choosing an Image Format 
See the documentation that came with your computer system to determine the 
number of pixels that your screen can display. 

For viewing purposes, choose an image size that is no larger than your display 
screen. You can display an image that contains more pixels than your screen, but 
the image is cut at the edges. 

Consider the width-to-height ratio of your screen and of the desired view. ARC+ 
Render Pro extends the view according to the image size that you define. 

If you wish to transfer an ARC+ Render Pro image to another program see 
program-specific information to determine which file formats it can read. If you 
have difficulty reading a compressed file format with another program, try an 
uncompressed format instead. 

If you are transferring the file for printing, consider the resolution of the printer 
when you choose an image size. Many laser printers, for example, offer a 
resolution of 300 dots (pixels) per inch. To exploit this resolution fully, choose an 
image size that contains 300 pixels for each inch (2.54 cm) of the planned printed 
dimensions. You can use paper size wizard to automatically calculate image size 
based on target page size and orientation, margins and DPI. See Paper Size 
Wizard in this Chapter for further information. 

Effect on Computation Time 
A larger image (more pixels) takes longer to compute and occupies more space 
on your disk. 

 HINT   Preview your rendering using a small image size. When the results are 
satisfactory, produce a final rendering in a larger size. 

The choice of file format has no significant effect on computation time. 
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Setting the Image File Type 

Set the file type of the rendered image. 
 
\grimgset 
 
 

Render 
Setting 
 

 
From the menu select RENDER > SETTING 

The RENDER IMAGE SETTING dialog box is opened. 

  
IMAGE SIZE Specify the image size in pixels (width x height). You 

may choose between several predefined options 
ranging from 200 x 200 to 1280 x 1024 pixels, or you 
may type a custom size in the dialog box. Custom 
sizes may be as large as you want (2000 x 2000 for 
example), subject to the memory limitations of your 
computer.  
To use paper size wizard (automatically calculates 
image size based on target page size and orientation, 
margins and DPI) click PAPER SIZE. See Paper Size 
Wizard in this Chapter for further information. 

FILE NAME Specify a filename for the image, using any filename, 
but you should use the conventional file extension 
(listed in the table) to identify the file type on your 
disk.  
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Format File Extension True RGB Colors (24 bits) or 256 Colors (8 bits) 
ARC+ image .IMG 8 bits 
Windows bitmap .BMP 8 or 24 bits 
Tagged image file (TIFF) .TIF 8 or 24 bits 
Targa image .TGA 8 or 24 bits (also 16-bit and 32-bit options) 
PC Paintbrush .PCX 8 bits 
CompuServe bitmap .GIF 8 BITS 
JPEG .JPG 24 BITS 

 NOTE   In addition to the above formats, ARC+ Render Pro produces a temporary 
image file with the file extension .GRI. You may delete .GRI files if you find them in your 
disk directory. 

DITHERING Image dithering. Dithering is recommended to 
smooth color gradations in 8-bit file formats.  

Click the ... button to accept or reject your choices. A SAVE AS dialog box is 
opened. 

 
 
Use the DATA TYPE pull-down menu to choose the true-color (24 bit) or 256-color 
(8 bit) option for the file type. 
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Use the COMPRESSION pull-down menu to select a compression option, if one is 
offered for the file format you have chosen. Compression is always 
recommended, unless you are transferring the file to another program that 
cannot read the compressed format. 

Save the file. 

 

Paper size wizard 

The paper size wizard automatically calculates image size based on target page 
size and orientation, margins and DPI. 

Click PAPER SIZE in IMAGE SETTING dialog box. 

The PAPER SIZE dialog box is opened. 

 
 

PAPER SIZE Select the target paper size from PAPER SIZE combo 
box, or type custom paper width and height. 

DPI Output resolution is defined in terms of the number 
of dots per inch, or DPI. The ideal is to match the 
resolution of an image to the resolution of the output 
device, usually a computer screen or printed 
document. The higher the dpi of the image (up to the 
limit of the output device), the better the quality of 
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the printed image. Typical ink-jet and laser printers 
print from 150 dpi to 300 dpi. Typical monitor 
resolution is 96 dpi. Select DPI from the DPI combo 
box, or type value.  

ORIENTATION Select the page orientation: Portrait or Landscape. 

MARGINS Page margins are the space around the edges of the 
page. 

 

 

Rendering Quality 
There are three main factors that influence the quality of the rendered image: 

� Shading option: the way the illumination on each surface of your model is 
computed. 

� Antialiasing: the smoothing of rough edges in the image that results from the 
digital nature of the rendering computation. 

� Shadows, reflections, and transparency: the presence of realistic optical 
effects in your image. 

Shading Options 
You can choose several shading options, which determine how ARC+ Render Pro 
computes the illumination falling on surfaces of your model. By choosing an 
appropriate shading option, you can ensure a high degree of realism in your 
image and also minimize the time required for the rendering computation. 

The shading options differ in their treatment of two types of illumination: 

DIRECT ILLUMINATION Light falling directly from a light source (including 
ambient light) onto any point of the model. 

INDIRECT ILLUMINATION Light that is reflected onto a surface from another 
surface of the model, or transmitted onto the surface 
through a transparent or partially transparent 
material in the model. 

 NOTE   Light passing through an opening (hole) in the model is direct illumination. 
Light passing through a transparent solid in the model, such as a window pane, is 
indirect illumination. 
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In increasing degrees of realism and computation time, the following shading 
options are provided.  

NO SHADING ARC+ Render Pro ignores both direct and indirect 
illumination. The model is rendered as though it were 
illuminated in uniform, non-directional, white light. 
The image is produced very quickly but lacks a 
feeling of three-dimensions. 

FLAT SHADING Each surface of the model has a different but uniform 
shading, determined by its average angle to each 
light source. There are no gradations of illumination 
or shade on the surface. Indirect illumination is 
ignored. 

GOURAUD SHADING The illumination is computed at the corners of each 
surface and interpolated at interior points of the 
surface. Gradations of illumination are continuous 
across the surface. The effect is realistic, but sharp 
highlights or shadow lines cannot be observed. 
Indirect illumination is ignored. 

PHONG SHADING The illumination is computed at each point of each 
surface. Accurate gradations of illumination are 
computed. Sharp highlights and shadow lines are 
displayed. Both direct and indirect illuminations are 
realistically represented. 

RAY TRACING Individual rays of light are traced from each light 
source to each point in the model, as they bounce 
from surface to surface within the model, and back to 
the observer's eye. Both direct and indirect 
illuminations are realistically represented. 

Choosing a Shading Option 
RAY TRACING ADVANTAGES: Produces the highest quality images. 

Fully exploits the material attributes assigned to 
entities in your model, such as reflectance and 
transparency (see Chapter 2, ATTRIBUTES, Materials). 
DISADVANTAGES: Ray tracing also takes much longer 
to run than the other methods.  

PHONG SHADING ADVANTAGES: Provides results similar to ray tracing, 
including the effects of reflective and transparent 
materials.  This options runs much faster than ray 
tracing. 

FLAT AND GOURAND ADVANTAGES: Used  to preview model before final 
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SHADING rendering. 
DISADVANTAGES: Options are of more limited use. 

NO SHADING ADVANTAGES: Useful to preview the color and texture 
attributes of entities in your model. Since this option 
ignores your lighting scheme, it runs very fast and all 
colors and textures are rendered without change of 
tint, exactly as you assigned them. 

Effect on Computation Time 
Many factors influence the computation time required to produce the rendered 
image. They include (in approximately decreasing order of importance): 
� Speed of your computer 
� Number of pixels in the image file 
� Number of lights 
� Acceleration (ray tracing only) 
� Number of ray samples per light and maximum ray depth (in ray tracing 

only) 
� Checking for reflections and transparency 
� Antialiasing (mainly in ray tracing) 
� Checking for shadows 
� Number of polygons in your model (mainly in ray tracing) 
� Complexity of textures 

The following table helps you choose the best recommended method for given 
parameters: 

Shading method Preview method Computation time 
Ray tracing Flat or Gouraud shading several minutes to many hours  
Long ray tracing Phong shading overnight or weekend run 
Phong shading Other shading methods Seconds - minutes 

 IMPORTANT   There is an important exception to these recommendations. If your 
image size is very large (more than about 1000 x 1000 pixels), you may receive OUT OF 
MEMORY messages during rendering. If this occurs, try ray tracing, which uses less 
memory than the other methods. 

Antialiasing 

Because computer images consist of pixels, no true diagonal or curved lines can 
be displayed in the image. Instead, the lines are approximated by short steps of 
horizontal or vertical line segments. If you look closely, you can sometimes see 
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the steps, which give the diagonals or curves a rough appearance. This 
phenomenon is called aliasing in computer graphics jargon. 

To prevent this, choose the antialiasing option. In the step region, antialiasing 
divides each pixel into a few parts and computes the average color of the parts. 
This produces a more realistic effect, smoothing over the discontinuities. 

To choose the antialiasing option, you must specify: 

SAMPLE PER PIXEL The number of parts into which each pixel is divided. 
The range of sampling values is 1 (no antialiasing) 
to 25. 

For ray tracing, you can also select: 

ADAPTIVE SAMPLE PER 
PIXEL 

Decreases computation time by applying antialiasing 
only where it is most needed. 

Effect on Computation Time 
With all shading options except ray tracing, antialiasing takes only a short time. 
In ray tracing, the computation time increases when a higher sampling value is 
employed. 

Usually, a sampling value of about 4 produces good results in ray tracing. With 
the other shading options, a value of 8-10 is recommended. 

Shadows, Reflections, and Transparency 
To save time, as in a preliminary rendering, turn the shadows option off. If you 
do this, ARC+ Render Pro does not check whether a surface of your model is 
SHADOWED from a light source by other surfaces in your model. Therefore all 
shadows are eliminated from your image. 

With all shading options except ray tracing, you can set the shadows level 
parameter (range 1-10, default 2). This parameter controls how shadows are 
computed in your image. Increase the parameter value if shadows appear 
patchy or uneven. Decrease the value if you receive IGNORE LIGHT warnings 
during the rendering computation. 

If you choose the phong or ray tracing option, you can save time by turning off 
reflections and transparency. If you do this, the effects of indirect illumination 
are ignored. Alternatively, you may specify a threshold value of reflectance and 
transparency at which indirect illumination is computed. Materials with 
reflectance and transparency lower than the threshold are treated as non-
reflective and/or opaque (see Chapter 2, ATTRIBUTES, Materials). 

Another way to save time in ray tracing is to reduce the maximum ray depth 
parameter (range 1-10, default 6). The maximum ray depth is the number of 
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surfaces that a single light ray can hit as it bounces around your model. For 
example, the maximum ray depth controls the number of reflections that are 
computed between a pair of parallel mirrors. 

Acceleration Option 
You can reduce the computation time required for ray tracing by as much as 
50%, by selecting an option called acceleration. 

 IMPORTANT   Acceleration is effective only if the ray tracing includes indirect 
illumination, i.e., transparent or reflective materials. The acceleration applies only to ray 
tracing, not to the other shading options. 

Choose an acceleration value from 1-6 (default 2). A value of 1 is equivalent to 
the ray tracing method employed in previous releases of ARC+ Render Pro. A 
value of 2 significantly speeds up the ray tracing with no effect on image quality. 
Higher values produce a greater acceleration with only a minor negative effect 
on quality. 

To optimize ray tracing performance, try setting the maximum ray depth to the 
default value of 6 and increasing the acceleration value to the highest value that 
gives good image quality. 

Setting the Rendering Quality 

Quality Setting for All Shading Options Except for Ray Tracing 
Set the antialiasing option and other options affecting image quality, for all 
shading options except for ray tracing. 
 
\grqlty 
 
 

Render 
Setting 
 

 
Click the RENDER QUALITY tab in the RENDER dialog box. 
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Specify the SAMPLE PER PIXEL value for antialiasing (set to 1 if antialiasing is not 
desired).  

Specify whether to compute shadows. Set the value of the shadows level by 
entering a numerical value or adjusting the slide bar. 

If you choose the PHONG option, specify whether the computation should 
include indirect illumination-reflections and/or transparency. If you include 
REFLECTIONS and TRANSPARENCY, you may also specify the THRESHOLD value of 
material reflectance and transparency at which the system computes indirect 
illumination. 

Click OK and exit the dialog box. 

Quality Setting for Ray Tracing  
Set the antialiasing option and other options affecting image quality, for the ray 
tracing option. 
 
\grqlty 
 

Render 
Setting 
 

 
Click the RAY TRACING QUALITY tab in the RENDER dialog box.  This step was 
discussed earlier in this chapter. 

Follow the Render wizard windows as directed. 
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Producing the Rendered Image 
� ARC+ Render Pro provides two commands that produce a rendered image.  

The render wizard guides you through all the necessary steps. Render 
(\grender): if you have chosen the no shading option or the flat, Gouraud, or 
Phong shading options 

� Ray tracing (\rungrt): if you have chosen the ray tracing option. 

Before you use either of these commands, assign rendering attributes to the 
entities of your model, and set the view, lighting conditions, image file type, and 
rendering quality options. 

 NOTE   You cannot edit or further render an image file with ARC+ Render Pro. To 
improve or alter the rendering of an image file, change the rendering attributes or 
options and perform the rendering again. 

Rendering the Model 
As discussed at the beginning of this chapter, you can define all scene 
parameters to define your final rendered scene. 

Render your model with the no shading option or with the flat, Gouraud, or 
Phong shading option. 

\grender 
 
 

Render 
Image 

   
The RENDER dialog box opens  

Setting Shading Option 
Set the shading option in the RENDER dialog box. 

Select a RENDERING MODE. Make sure the selected camera is the desired view for 
the rendered image. Press NEXT, and a wizard will guide you through the 
procedure of defining the production settings. 

 IMPORTANT   If you choose the ray tracing option, then you must perform the 
rendering using the Perform ray tracing (\rungrt) command. If you choose any other 
shading option, then you must perform the rendering using the Rendering the model 
(\grender) command. 
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Select type of animation and immediate or delayed rendering in this dialog box.  

RENDER 

IMAGE Image created with attributes (see Chapter 2, 
Attributes and earlier in this chapter for further 
information). 

ANIMATION Available animations: walk-through (see Chapter 6, 
Walk-through Animation for further information) and 
lighting animation (See Chapter 7, Lighting Animation 
for further information). 

CAMERA Camera views available and can changed as required. 

RUN 

NOW Render the scene now. 

LATER Render scene at a later time.  See Make Later and 
Make Batch in Chapter 6, Walk-through Animation for 
further information. 

JOB NAME If you chose to render now, The job name given is 
automatic.  If you choose to render later you can 
rename job as desired. 
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RENDER MODE 

SHADING CHOICES Choose desired shading, see Chapter 1, Attributes for 
further information.  

ESTIMATED DISK SPACE Lists drive, required space and actual space available. 

You can select NEXT to set all the required rendering parameters in the IMAGE 
SETTING and RENDER QUALITY dialog boxes. The dialog boxes are very similar to 
the ones displayed during the quality setting session. The difference is that the 
settings now apply to the production process, not the rendering mode. The 
render wizard facilitates easy step-by-step navigation through this process, 
using pre-determined dialog boxes. 

Click NEXT to advance from one dialog box to the next. Carefully examine all the 
settings in all the dialog boxes, to avoid production errors. 

When all the parameters are set, click FINISH. The production process begins 
immediately without requesting further information. 
 

  
 IMPORTANT   Do not use this command if you have chosen the ray tracing option in 

the Setting rendering quality (\grqlty) command. The ray tracing option is ignored by 
this command and phong shading is used instead. 

 NOTE   You are warned if the image filename that you have specified (see Setting image 
type, earlier in this chapter, \grimgset command) already exists in your disk directory. If 
so, choose to overwrite the existing file or specify a different filename. 

The screen displays the progress of the rendering computation plus any warning 
messages regarding aspects of the computation. Click STOP, at any time to stop 
the computation and exit the command. 



Rendering   

5-16  ARC+ Render Pro User's Guide 

When the computation is complete, the rendered image is displayed and the 
image file is automatically saved on your disk under the filename that you have 
specified. 

The rendered picture is displayed in a small window. Click the WINDOW EXPAND 
icon if you wish to display the image on the full screen. Click the WINDOW 
CLOSING icon to clear the screen and exit the command. 

Perform Ray-Tracing 

Render your model by the ray-tracing method. 
 
\rungrt 
 
 

Render 
Image 
 

 
The  RENDER dialog box opens (see SETTING SHADING Option, earlier in this 
chapter). You can select NEXT to set all the required rendering parameters in the 
IMAGE SETTING and RAY TRACING QUALITY dialog boxes. The render wizard 
facilitates easy step-by-step navigation through this process, using pre-
determined dialog boxes. 

When all the parameters are set, click FINISH.  

The command begins immediately without requesting further information. 

 IMPORTANT   Use this command only if you have chosen the ray tracing option in the 
Setting rendering quality (\grqlty) command. Any other shading option is ignored by 
this command and ray tracing is performed instead. 

 NOTE   You are warned if the image filename that you have specified (see Setting image 
type earlier in this chapter, \grimgset command) already exists in your disk directory. If 
so, choose to overwrite the existing file or specify a different filename. 

The screen displays the progress of the ray tracing computation plus any 
warning messages regarding aspects of the computation. 

Click STOP, at any time, to stop the computation and exit the command.  A 
prompt enables you to save the partial computation and resume it at a later time. 
To continue, open the model in ARC+ (if it is not already open), enter ARC+ 
Render Pro, and choose the PERFORM RAY TRACING (\rungrt) command again. 
Choose to RESUME from where the computation was interrupted or to RESTART 
from the beginning. 
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When the computation is complete, the ray-traced image is displayed and the 
image file is automatically saved on your disk under the filename that you have 
specified.  

The rendered picture is displayed in a small window. Click THE WINDOW EXPAND 
icon if you wish to display the image on the full screen. Click the WINDOW 
CLOSING icon to clear the screen and exit the command. 

Recording Rendering Data in a Logfile 
You can output the messages from the rendering or ray tracing process to a file. 
The messages are similar to those displayed on the rendering or ray tracing 
screens. 
 

 
 

Tools 
Options 
Logfile 

 
The OPTIONS dialog box is opened. Select the LOGFILE tab. 
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In the dialog box, select the following options: 

WRITE MODE 

NO LOG No log file is written. 

REPLACE LOG Replace messages from previous rendering sessions 
in log file with current messages. 

APPEND LOG Append current rendering session messages to 
previous messages in log file. 

FILE NAME 

BY MODEL NAME Store the logfile under the same name and in the 
same directory as the model. The file extension is 
*.log. 

OTHER NAME Specify the name and directory to store the logfile. 

You can read the log file using any ASCII editor or within ARC+ Render Pro. 
 

 
 
 

Edit 
View Log File 
  

Displaying an Image 
After you produce an image, it is saved as an image file on your hard disk. You 
can recall an ARC+ Render Pro image file at any time and display it on the 
ARC+ screen. 

You can also display an image file created by another program if it conforms to 
one of the standard file formats supported by ARC+ Render Pro. You can 
display an image that contains more pixels than your screen, but the image is cut 
off at the edges. The image is displayed immediately and the rendering 
computation is not repeated. 

Displaying an Image File 
Display an image file on the ARC+ screen. 
 
\grimgshw 
 
 

Render 
Show Last / Show > Image 
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Choose to display either the last (most recent) image, or another image. If the 
latter, specify the disk directory, file type (extension), and file using the dialog 
box. From the command bar, select EDIT > PROPERTIES to display information 
such as the file name, size (in bytes) and dimensions (in pixels) and the type of 
compression.  

The image is displayed in a window. Double-click the window header, or use 
the window expand icon to display the image on the full screen. 

 NOTE   If you specify a new filename in the Setting the image file type (\grimgset) 
command, you can no longer use the SHOW LAST IMAGE option. Use the SHOW IMAGE 
option instead. 
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WalkWalkWalkWalk----through Animatthrough Animatthrough Animatthrough Animationionionion    

 
The ARC+ Render Pro walk-through animation module provides a powerful 
artistic and marketing tool to the static rendered images.  Walk-through 
animation enables you to view an image from any number of vantage points, 
including panoramic, ceiling, as well as, walk around objects and through doors 
and the like.  ARC+ Render Pro also offers lighting animation discussed in detail 
in Chapter 7, and objects animation discussed in detail in Chapter 9. 

You can add animation before or after rendering the image, although it is 
recommended to render the image before adding the animation. 

Animation is created and measured in key frames and frames.  A key frame in 
walk-through animation is simply a camera angle.  The animation is produced 
by creating a series of camera angles moving along a given path.  Frames are the 
measurement of images between key frames, compared to the frames of a movie 
or cartoon that are viewed at high speed to create the illusion of movement. 

To obtain a lifelike walk-through of the image, it is important to understand the 
steps involved in creating the path of camera angles and the timing from key 
frame to key frame.  For example, you can create a short walk-through around a 
table in a few simple key frames.  To produce a smooth animation walk-through 
of a room or a tour of an apartment complex requires attention to sequence of 
the tour and the time it takes to make or compile this animation, your computer 
may need to run for a few hours or overnight. 

6
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Animation File Types 
You can choose to create the image file in various industry-standard formats: 

Format File Extension True RGB Colors (24 bits) or 256 colors ( 8 bits) 
Windows AVI file .AVI 8 or 24 bits 
FLI Autodesk file .FLI 8 bits 
GIF Animation file .GIF 8 bits 
Image List File .LST 8 or 24 bits 
Image File List .IFL 8 or 24 bits 

Setting Animation Parameters 

\ 
 
 

Paths 
Camera Path 
 

 
From the menu select PATHS > CAMERA PATH 

The top and front work windows (default views) change to gray. 
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Once you begin to create the key frame path, the graphic display is shown in 
these two work windows, according to their specified view (the top view 
displays the key frames from an aerial view, while the front view displays a cut-
across view).  The view in the perspective work window moves along with the 
path created. 

The two methods used to create an animation walk-through or path, using the 
Animation Wizard or creating paths manually are described below. 

Animation Wizard 
The Wizard simplifies path creation, especially for first time users.  Select EDIT > 
NEW from the menu bar or right click the mouse in any of the work windows.  
Select New from the drop down menu.  A NEW dialog box opens. 

 
This wizard is designed to be utilized for cameras (see Chapter 3, Cameras, for 
more information), lights (see Chapter 4, Lighting, for more information) and for 
paths or animation walk-throughs. 

Click the + sign on the side of the Path branch to open path options.  The three 
path options are path (default) enabling you to follow a straight or curved route; 
circle enabling you to circle the entire scene and spiral enabling you to spiral up 
or down through a scene. Selecting either circle or spiral activates the Settings 
option, enabling you to choose exterior (view from around the outer perimeter 
of the scene) or interior (view from within the scene). 

When working with either a spiral or circular path in exterior mode, it is 
recommended that you click the Zoom Full icon on your tool bar, to view the 
entire scene.  Click the Zoom Work Area icon to return to the normal scene view. 

The wizard automatically creates the first key frame, represented as a red line 
drawn from the selected direction toward the center of the screen. 
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Animation Toolbar 
The animation toolbar contains the following icons: 

 
CURRENT FRAME   Current frame. 

 
PLAY Play created animation. 

 
STOP Stop running animation. 

 
GO TO FIRST FRAME Click to return to first frame created. 

 
GO TO PREVIOUS 
KEY FRAME To tour the created path, frame by frame, click this 

icon or the GO TO NEXT KEY FRAME icon.  A yellow line 
appears that moves from frame to frame along path 
in desired direction. 

 
PREVIOUS FRAME Jumps back to previous frame. 

 
GO TO NEXT FRAME Jumps to next frame. 

 
GO TO NEXT KEY FRAME To tour the created path, frame by frame, click this 

icon or the GO TO PREVIOUS KEY FRAME icon.  A yellow 
line appears that moves from frame to frame along 
path in desired direction. 

 
GO TO LAST FRAME Jump to last frame. 

 
ADD KEY FRAME Toggle on/off feature.  Toggle On to create animation 

path.  Toggle Off to edit or stop animation path 
creation. 

 
DELETE KEY FRAME Delete specific key frame. 

 
MAKE KEY FRAME To change a frame into a key frame, select the frame 

and click the Make Key Frame icon. 

Create Paths Manually 
To create paths manually, select PATHS > CAMERA PATH as described above. Click 
the Add Key Frame icon (toggle feature) on the animation toolbar.  Once this 
icon is toggled on the cursor symbol changes from an arrow to a + sign. 
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You can create and modify key frames in either of the two windows, as they 
both display the exact same scene. 

To create the first key frame, position the mouse on the first point and click.  A 
red line is automatically drawn in the camera direction, towards the center of the 
image. 

To continue the path of the walk-through, move the mouse in any direction or to 
any point and continue to click to create as many key frames as desired.  Keep in 
mind that a smooth path of key frames, makes a smooth moving animation.  
You can also drag and click to any position to get the same results.  The number 
of key frames created is displayed on the animation icon line. 

As discussed earlier in this chapter, the key frames are actually camera views 
and as such, with each new key frame the Perspective window displays the 
corresponding view of the animation. 

Camera Properties 
As discussed, as long as the Add Key Frame icon is pressed, key frames can be 
added.  To further define and determine camera parameters and functions, right-
click the mouse on the camera view branch of the tree. 

Click Properties in the menu to open the CAMERA PROPERTIES dialog box. 

 
If this is a new image (without key frames), the CAMERA PROPERTIES dialog box 
contains only three tabs 

GENERAL Describes the camera view. 

GEOMETERY Describes the XYZ coordinates of the camera view. 

ANIMATION This window is inactive as there are no key frames 
available. 
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Adding a key frame activates the animation tab and adds an additional tab to 
this dialog box. 

ANIMATION Displays number of frames and key frames created as 
well as path used. 

KEY FRAME Describes the current key frame parameters. 

Modifying Key Frames 
The camera properties of each individual key frame can be modified.  To modify 
the current key frame, click to display the CAMERA PROPERTIES dialog box.  If you 
wish to modify an existing key frame, toggle off the Add Key Frame icon, then 
click the desired key frame to display the dialog box.  Click the Key Frame tab. 

 
This tab displays the current key frame number, along with the following 
features. 

LINE TYPE Enables you to choose the type of line or camera view 
for this key frame.  Line (default) is a straight path.  
Curve displays a blue line and enables you to bend or 
arch the path at this specific point. Break extrapolates 
the path without a view, i.e., it goes through the 
frames without moving until it reaches the next key 
frame.  In essence standing in one place (going the 
curved, or a break between this key frame and the 
next).  You can use this kind of break to zoom in or 
out of a certain specific area of the scene. 

TARGET TYPE The target is the direction the camera faces.  This 
feature enables you to determine how the target 
behaves when changing the location of the camera.  
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Point (default) indicates that the camera is always 
pointed in the same direction even if the camera itself 
changes location.  Delta changes the camera direction.  
You can determine the direction for each camera 
separately, while keeping the same parameters, and 
therefore view a different path with each.  Walk 
enables the camera to follow in the direction you are 
going. 

CONTROL This feature enables full control over the type of key 
frame used, from either a geometric or eye view.  
Line allows you to control only the key frame's eye; 
direction and geometric parameters are determined 
by the previous key frame.  Data enables you to 
determine only geometric parameters and not the 
eye.  Full enables you to control all key frame 
parameters. 

Modifying Animation Path 
The animation path of an image can be determined at any time, either while the 
animation is being created or once it has been completed.  Click the path to open 
the CAMERA PROPERTIES dialog box.   Click the Animation tab. 

 
This tab displays the total number of frames, as well as the key frame currently 
chosen.  To choose data type, click the desired radial button. 

PATH TYPE 

SINGLE One single walk-through course. 
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LOOP A continuous walk-through sequence, beginning at 
the start and then retracing its steps from end to 
beginning and back again. 

REPEAT A sequence that begins at the start and goes through 
to the end and then begins again at the beginning in a 
continuous movement. 

CLOSE Closes the path from the last key frame created to the 
first key frame. 

SMOOTH Animation effect described below. 

Smoothing 
When creating an animation of a scene it is important to keep the following in 
mind. When creating a path, you position key frames according to a route you 
wish to walk through. 

� Along your route you turn a corner or walk straight through a parking lot or 
sweep through a certain part of a scene.  Each of these movements is 
represented by key frames.  However, after making or compiling the 
animation you may find that the movement through certain parts of the 
route is quicker or slower than others due to the distance between key 
frames. 

� The default frame rate, discussed below, is 10 frames per key frame.  Since 
these same 10 frames exist between two key frames positioned far apart, as 
well as two key frames positioned very close together.  The frame rate 
translates into the amount of time it takes to travel between key frames. 

The smoothing process evens out or smoothes the difference to create a new 
division of the key frames, thus creating a smooth walk-through. 

Click the Smooth button on the Animation tab to open the SMOOTH dialog box. 

 
Click radial button to choose either all key frames or just a specific range of 
frames, should you wish to follow the nature flow of the area. You can also add 
on additional frames to create a better quality animation during viewing.  Click 
appropriate radial button.  Click OK to automatically return to the previous 
window. 
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Setting Frame Rate  
As discussed, the frame rate is the number of frames between key frames.  The 
default is 10.   

To modify this rate click TOOLS > OPTIONS.  Click Animation tab.  Click desired 
rate and OK. 

You can also set the temporary files swap folder location, used in rendering the 
animation files.  Click the ... button to browse for a different location.  Click the 
default button to return to all default settings.  Click OK to return to previous 
window. 

 

View Options — Animation 
The key frame lines, as well as the entire animation path line can be modified. 

Right-click your mouse in either the Top or Front view windows.  Select Options 
in the menu to open the VIEW OPTIONS dialog box.  This dialog box is discussed in 
greater detail in Chapter 3, Cameras. 
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Click the Animation tab. 

 
Select one or more of the following choices, and then click the Apply button to 
view choices without leaving this dialog box.  Click OK when you finished. 

DRAW CURVE ARROWS This is a curve control feature.  When activated, a 
small blue ribbon shape appears on the current key 
frame, enabling you to curve the path. 

DRAW TARGET ARROWS This displays or hides the target line of each frame 
created (red colored line).   

DRAW FRAME MARKS Displays all frames between each key frame (yellow 
line). 

DRAW PICKED FRAME ONLY Displays only line picked.  This view is recommended 
when working with a complex path. 
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Camera Tree View 
As in all ARC+ Render Pro features, you can view the key frames created in the 
extended camera branch of the tree. 

 

Path Frames 

\ 
 
 

Paths 
Frame Settings 
 

 
From the menu select PATHS > FRAMES SETTINGS 

This opens a graph window representing a timeline of key frames.  The movable 
buttons located on this line correspond to the key frames created.  This window 
enables you to manually change the position of a key frame from one point to 
another.  
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Rendering a Walk-through Animation 
Once you have created the path of key frames and modified the timing and 
smoothness of the route sequence, it is time to make the animation.  You have 
several make options, including: making the animation immediately, making a 
preview, making it later and creating a batch of animation files for scheduled 
making. 

Animation — Make 
\ 
 
 

Render 
Animation 
 

 
From the menu select RENDER > ANIMATION 

The RENDER dialog box opens.  
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RENDER The animation radial button is activated (default).  

The default camera view is selected in the drop down 
menu.  

RUN Animation choices to schedule later (see Make Later, 
discussed later in this chapter). 

RENDERING MODE See Chapter 5, Rendering for further information 
regarding these settings. 

 NOTE   If you change the settings in the Rendering Mode, they will become the default 
settings the next time you make or change something in the Render feature setup. 

ESTIMATED DISK SPACE Displays drive, disk space required and available. 

Click the Next button to open FRAMES SETTING dialog box. 
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SETTING 

FRAME FROM Set From and To frame parameters for animated 
rendering. 

EVERY Set number of frames to jump within the animated 
rendered scene.  For example, if you set the 
parameter to 5, then every fifth frame is animated. 

REPEAT Set number of times each frame in the scene is 
repeated. 

FRAME RATE Set the number of frames to seconds ratio. 

ESTIMATED DISK SPACE Displays drive, disk space required and available. 

Click the Next button to open IMAGE SETTING dialog box. 
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The IMAGE SETTING dialog box enables you to determine the following 
parameters. 

IMAGE SIZE See Chapter 5, Rendering, for further information 
regarding these settings.  

FILE NAME See beginning of this chapter for explanation on file 
options. 

DITHERING See Chapter 5, Rendering, for further information 
regarding these settings. 

FIND OPTIONAL PALETTE See Chapter 2, Attributes, for further information 
regarding color palettes. 

SAVE RECOVER 
INFORMATION 

As the make animation process can take a long time 
and there is a possibility of outside problems, such as 
a power failure or a computer system failure, this 
feature enables recovery of the make process from the 
beginning until the process was stopped. 

ESTIMATED DISK SPACE Displays estimated disk space required. 

Click the Next button.  The next dialog box opened depends on the Rendering 
Mode option chosen in the RENDERING dialog box. 
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 NOTE   You can click the Finish button at any time, even in the first dialog box. 

Click the Finish button to begin making or compiling the animation.  A MAKE 
dialog box opens.   

If you are working in an AVI format, a VIDEO COMPRESSION dialog box opens 
automatically in front of it.  

 
The VIDEO COMPRESSION dialog box contains a drop down list of compression 
choices.  Select compression and click OK to view MAKE dialog box.   

 
This dialog box contains general file information, current making or compiling 
status.   

Click the >> button to extend the window (the button changes to << when the 
window is opened).  This portion of the window displays all image compiling 
information, including errors and the like.   
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Animation - Make Preview 
\ 
 
 

Render 
Animation 
 

 
To create a preview of the animation before future rendering: 

From the menu select RENDER  > ANIMATION 

The RENDER dialog box opens, as displayed in Make Animation.  Select Preview 
(wireframe) as the Rendering Mode. 

Click the Next button to open IMAGE SETTING dialog box. 

In the IMAGE SETTING dialog box, the default file format is FLI.  

Animation - Make Later 
\ 
 
 

Render 
Animation  

 
To schedule animation for a later time: 

From the menu select RENDER  > ANIMATION 

The RENDER dialog box opens, as displayed in Make Animation.  Select LATER in 
the RENDER dialog box. 

Once all dialog boxes have been executed, a message box displays the window: 
"Job XXX was successfully added". 

This job is then added to the batch option described below.  

Animation - Make Batch 
\ 
 
 

Render 
Batch 
 

 
To work with one or more jobs scheduled for animation at a later time: 

From the menu select RENDER  > BATCH 

This opens the RUN BATCH FILE dialog box. 
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This dialog box contains a list of all the jobs created under the Run Later option.  
This dialog box displays all jobs - images, animation and panoramas - including 
the names, parameters (camera names, etc.), dates created and executed. 

To run batch, click RUN. 

To delete jobs from batch, click to select the desired jobs, and click DELETE. 

Click CLOSE to return to previous screen. 

Animation - Play  
 Render 

Show 
Animation 
 

 
From the menu select RENDER > SHOW > ANIMATION.  This opens a list of 
available animation files.  Select file and click OK to play created animation. 

 

 Render 
Show Last 
 

From the menu select RENDER > SHOW LAST to play last created animation: 

 

The following 12-scene strip presents an example of a walk-through animation.  
Note how the view changes and 'moves' through the scene, with each camera 
view. 
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Animated Textures 

In addition to walk-through animation abilities discussed in this chapter, 
lighting animation discussed in Chapter 7, and objects animation discussed in 
Chapter 9, ARC+ Render Pro offers animated texture capabilities.  Any 2D 
animated GIF file, AVI video file or image files list (IFL) can be attached as a 
texture, see Chapter 2, Attributes, for a full explanation of attaching textures. 

For example, an animated GIF can be attached to a TV screen to further enhance 
the real-life feeling of a scene. 

 

To view and edit animated texture properties of a texture use the TEXTURE dialog 
box ANIMATED tab. This tab is available for video texture file only. 

 
NUMBER OF FRAMEWS Number of frames in the animated texture. 

RANGE The range of frames used the animated texture. By 
default the number of frames contained in the 
original video file becomes the number of frames in 
the animated texture. 

TIME LINE 

DURATION (SEC) Duration in seconds of the animated texture. 

DURATION (FRAMES) Duration in frames of the animated texture. 
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START IN FRAME The number of frame in the animated texture to start 
from. 

TYPE 

SINGLE One single animation course. 

LOOP A continuous animation sequence, beginning at the 
start and then retracing its steps from end to 
beginning and back again. 

 

The following 6-scene strip presents an example of a texture animation.  Look 
carefully at the picture on the wall, the number and direction of the open end of 
the circle 'moves' with each scene. 
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Lighting AnimationLighting AnimationLighting AnimationLighting Animation    

 
Lighting animation is an add-on module, similar in basic technique to the walk-
through animation module discussed in Chapter 6.  As in the walk-through 
animation, lighting animation provides another creative enhancement to the 
static rendered images.  Lighting animation enables you to illuminate as well as 
to change the type of illumination viewed while touring the scene.  

A scene can be enhanced with lighting animation in two ways: 

� The scene remains static, that is, you only look at one view of the scene, and 
the lighting itself moves and changes direction, color or shape throughout the 
scene. 

� Both the scene and the light move and change.  As you tour the scene the 
lighting moves, changes color, shape and moves in its own pattern. 

Before working with lighting animation, it is recommended that you review 
Chapter 4, Lighting and Chapter 6, Walk-through Animation, in order to re-
familiarize yourself with all the lighting and animation features. 

 NOTE  It is important to keep in mind: Animation is created and measured in key 
frames and frames.  A key frame is simply a camera angle.  The animation is produced by 
creating a series of camera angles moving along a given path.  Frames are the 
measurement of images between key frames, compared to the frames of a movie or 
cartoon that are viewed at high speed to create the illusion of movement. 

7
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Animation File Types 
You can choose to create the image file in various industry-standard formats: 

Format File Extension True RGB Colors (24 bits) or 256 colors ( 8 bits) 
Windows AVI file .AVI 8 or 24 bits 
FLI Autodesk file .FLI 8 bits 
GIF Animation file .GIF 8 bits 
Image List File .LST 8 or 24 bits 

Setting Animation Parameters 

As discussed earlier in this chapter, it is recommended to review Chapter 6, Walk-
through Animation to re-familiarize yourself with all aspects of the animation 
process.  The following section incorporates the lighting animation feature into 
the animation process.  

 

\ 
 
 

Paths 
 Light Path 
 

 
As with walk-through animation, lighting animation begins with setting the 
animation parameters.  From the menu, select PATHS > LIGHT PATH 

The top and front work windows (default views) change to gray. 

Once you begin to create the key frame path, the graphic display is shown in 
these two work windows, according to their specified view (the top view 
displays the key frames from an aerial view, while the front view displays a cut-
across view).  The view in the perspective work window moves along with the 
path created. 

The two methods used to create an animation walk-through or path, using the 
Animation Wizard or creating paths manually, are described below. 
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Animation Wizard 
The Wizard simplifies path creation, especially for first time users.  Select EDIT > 
NEW from the menu bar or right-click the mouse in any of the work windows.  
Select New from the drop-down menu.  A New wizard dialog box opens. 

Click the + sign on the side of the Light branch to expand this branch.  
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As discussed in Chapter 4, Lighting, the lighting options available are: 

� Point Light 
� Spot Light 
� Distant Light 

Each option has seven lighting positions: top, bottom, left, right, front, back and 
axo. Selecting one of these positions activates the Settings option (to the right of 
the tree), enabling you to choose exterior (view from around the outer perimeter 
of the scene) or interior (view from within the scene) 

Select desired lighting option and position (optional) and click New. 

Click Add Key Frame icon and begin creating the path as discussed in the 
previous chapter.  Review the Animation toolbar discussed in Chapter 6, Walk-
through Animation. 

As in walk-through animation, to create the first key frame, position the mouse 
on the first point and click.  A red line is automatically drawn in the camera 
direction, towards the center of the image. 

Lighting properties, such as lighting options, color, direction, cone angles can be 
modified and tailored to fit a certain type of lighting or area of the scene.  For a 
full explanation of these features, see Chapter 4, Lighting. 

Working with Lighting Animation - How to Overview 

As discussed earlier in this chapter, lighting animation can be utilized in two 
basic methods.  These basic methods can, of course, be improved, modified and 
transformed according to project requirements, technical skill and imagination. 

It is important to keep in mind that modifying certain parameters change the 
default settings for the next action.  In this case, if you worked with a walk-
through animation, you need to open a new scene in order to work with a static 
scene with animated lighting.  

Method One: 

The scene remains static, that is, you only look at one view of the scene, and the 
lighting itself moves and changes direction, color or shape throughout the scene. 

How to: 

� Click Paths > Light Paths on the menubar. 
� Click Edit > New on the menubar or right-click on work window to open 

drop down menu and select New. 
� Expand Light branch and select light option and position. 
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� Click Add Key Frame icon to begin creating lighting animation and continue 
moving through the scene. 

� To modify light options, toggle off the Add Key Frame icon, right-click 
desired key frame to open Light Properties dialog box. 

� Render as explained in Chapter 5 Render and at the end of Chapter 6, Walk-
through Animation.  

Method Two: 

Both the scene and the light move and change.  As you tour the scene the 
lighting moves, changes color and shape and moves in its own pattern. 

How to: 

� Reset walk-through default 
� Follow all the steps explained above. 

Once you have created the types of light effects desired along the path, as well as 
defined the path desired (using the modifying, smoothing, setting frame rate, 
etc. features), you can render your scene as described in Chapter 6, Walk-through 
Animation. 

The following 8-scene strip presents an example of a lighting animation.  Note 
how the type and color of light, as well as its location, change and 'move' with 
each scene. 
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PanoramaPanoramaPanoramaPanorama    

 
Panoramic rendering enables viewers to get a panoramic view of 3D designs. 
ARC+ Render Pro lets you create two types of interactive panoramas: 

1. Panoramic view - a 3600 panoramic view of a scene, as seen from a fixed 
point of view 

2. Panoramic objects – a 3600 view of an object, as seen from a moving point of 
view turning 3600 around a 3D model   

 
By Viewings your 3D designs in one of the modes described above, your client 

can get a full perspective of your design. The panoramas you create can be 

viewed within Arc+ Render Pro, sent to clients by email to be viewed using a 

stand-alone viewer, or published on the web. 

 

Producing a Panorama 
You can produce a panorama for any camera in the model. 

\ 
 
 

Render 
Panorama 
 

 
From the menu select RENDER > PANORAMA 
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Alternatively, you can choose Panorama from the Render toolbar. 
The render dialog box opens.  

 

 

 

 

PANORAMA The Panorama radio button is selected (default). The 
default camera view is selected in the drop down 
menu.  

RUN The Panorama file is produced directly at the end of 
the creation process. 

RUN LATER To schedule the creation of a panorama for later, 
select ‘Later’. Enter a name for the job. Complete the 
panorama creation process. After you click Finish, 
you’ll be presented with the message "Job XXX was 
successfully added".  
To run select Render > Batch. In the dialog box that 
opens, select the job(s) you want to run and click Run.  
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RENDERING MODE for more information concerning Rendering, See 
Chapter 5, Rendering  

 NOTE: If you change the settings in the Rendering Mode, 
they will become the default settings the next time you use 
the Render setup. 
 

ESTIMATED DISK SPACE Displays the required and available disk space. 

 
Click the Next button to open the image setting dialog box. 

 
The image setting dialog box enables you to determine the following 
parameters: 

IMAGE SIZE for information regarding Image size settings See 
Chapter 5, Rendering, Setting the Image File Type page 5-
4 

FILE NAME CLICK ON THE  button next to the Name box. In 
the dialog that opens, enter a name and select the file 
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type. LivePicture .Ivr is the default. You can also 
select VRML, which is a Panorama format requiring a 
VRML plug-in. 
Select the panorama type from the Mapping drop-
down menu at the bottom of the box: 
Cube mapping - Panoramic view 
Object mapping - Panoramic objects. If object 
mapping is selected, you may change the default 
number of sides you want the mapping to include 
 

Estimated disk space Displays the required and available disk space. 

 
Click the Next button.  If ray tracing was selected the Ray-Tracing quality-
setting dialog box is opened. If another rendering mode was selected The Render 
quality dialog box is opened  
 

 
Specify the sample per pixel value for antialiasing (set to 1 if antialiasing is not 
desired).  

Check the required options (Shadow Effect, Reflections and Transparency) and 
enter numerical values accordingly 

Ray Depth the number of surfaces that a single light-ray can hit 
as it bounces around a model 
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Acceleration Ray Tracing computation-time. The maximum value 
is recommended. It accelerates computation-time 
with minor reduction in image quality. 

When you are done, click Finish. 

Displaying a Panorama 
After you produce a panorama, it is saved as panorama files on your hard disk. 
You can display panorama in ARC+ Render Pro by choosing the panorama file 
in the dialog box. 

\ 
 
 

Render 
Show > Panorama 
 

 

Panoramas’ viewing options  

A panorama created in Arc+ Render Pro can be viewed within Arc+ Render Pro, 
using a stand-alone viewer, or published on the web. IVR panoramas are 
embedded in an html page and use a Java panorama viewer for viewing. The 
location of panorama viewer files can be defined before you create a Panorama, 
or changed later in the html file using an html or a text editor.  

You define how the panorama file will be viewed by specifying the location of 
the panorama’s Java viewer files (IVR CAB files). 

 

Selecting a viewing option 
\ 
 
 

Tools 
Options 
Panorama 

 
From the menu select Tools > Options 

In the dialog box that opens, select the Panorama tab and check the required 
option: 
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Software Folder To produce a panorama to be viewed within Arc+ 
Render Pro. The panorama viewer files are stored in 
your software folder. 

Target Folder To produce a panorama to be viewed using a stand-
alone viewer. The panorama viewer files are stored in 
a target folder (where your panorama file will be 
stored too). The panorama can be viewed 
independently of the software that created it, by 
sending the whole folder to other computers. 

Web To produce a panorama to be viewed on the web. The 
panorama viewer files are stored on the web, 
enabling easy publishing of your panorama on the 
web. If you select Web, you can change the default 
web address in which this panorama viewer will be 
stored. 

After you determine the location of the Panorama viewer, you can produce the 
Panorama file. 
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Objects AnimationObjects AnimationObjects AnimationObjects Animation    

 
Objects animation is part of Animator plug-in, similar in basic technique to the 
walk-through animation module discussed in Chapter 6.  As in the walk-
through animation, objects animation provides another creative enhancement to 
the static rendered images.  Objects animation enables you to move objects in 
your animation, and create impressive live animated scenes.  

Before working with objects animation, it is recommended that you review 
Chapter 6, Walk-through Animation, in order to re-familiarize yourself with all the 
basic animation features. 

 

Creating Objects Animation 
Animating an object is based on changing properties of the object in each 
keyframe along the animation time line. Objects in the scene can be manipulated 
in each keyframe: you can translate (change the position), rotate (change the 
orientation), and scale (resize) an object.  

The main workflow steps of object animation are as follows: 

� Go to keyframe 
� Define the transform properties of the object in the current keyframe 

 

Animation layout 

As discussed earlier in this chapter, it is recommended to review Chapter 6, Walk-
through Animation to re-familiarize yourself with all aspects of the animation 
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process.  The following section incorporates the objects animation feature into 
the animation process. 

 

\ 
 
 

Paths 
 Object Path 
 

 
As with walk-through animation, objects animation begins with setting the 
animation layout. From the menu, select PATHS > OBJECT PATH 

The top and front work windows (default views) change to gray. Once you 
begin to create the key frame path, the graphic display is shown in these two 
work windows, according to their specified view (the top view displays the key 
frames from an aerial view, while the front view displays a cut-across view).  In 
the perspective view, the object is moved along the motion path created. 
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Working with Objects Animation 

As discussed earlier in this chapter, objects animation is based on keyframes. 
You define the position, orientation and size of an object in each keyframe. 

 

The following example presents the steps to create motion path composed of 3 
keyframes. 

Step 1: 

� Click Paths > Object Path on the menu bar. 
� Click on the placed element that you want to move 
 

 
 

Step 2: 

� Go to next keyframe, for example: 11 (type the frame number in the 
animation toolbar, or click on the frame number in the frames view) 

� Drag the object to desired location 
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Step 3: 

� Go to next keyframe, for example: 21 
� Drag the object to desired location 
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The object path is ready. Click RUN in the animation toolbar, to preview the 
animation, Click STOP, to stop the animation preview. Produce the animation, as 
explained in Chapter 5 Render and at the end of Chapter 6, Walk-through 
Animation. 

 

Combining objects animation and video textures 

Video textures are also part of Animator plug-in. Object animation can be 
combined with video textures to create impressive effects. For example, you can 
animate placed element consist of single polygon with video texture of walking 
man attached to it. 

To edit the video texture properties, right click on the entity and select 
Properties. In the Attributes tab, double click on the texture. The video texture 
properties are shown in the ANIMATED tab. 

 NOTE   To select an entity, make sure that Entity Mode in the Objects toolbar is on. 
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The following strip presents an example of objects animation.  Note how the 
video texture of walking man is combined with object animation, while the 
video texture of standing woman is attached to static polygon. 
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Working with objects 
Entities such as placed element and RPC element are referred as objects in this 
chapter. Objects in the scene can be manipulated: you can translate (change the 
position), rotate (change the orientation), and scale (resize) objects. You can 
change the transform properties of an object in each keyframe.   

Selecting and manipulating objects 

You can select and manipulate objects in the scene using the Objects toolbar 
displayed below.  

 
The function of each icon is described below: 

 
SELECT  Select an object. The object is visually indicated as 

selected by changing its color. 

 
TRANSLATE  Select and translate (move) an object. 

 
ROTATE Select and rotate an object 

 
SCALE Select and scale (resize) an object 
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ENTITY MODE When entity mode is on, click picks an entity such as 

polygon and solid (suitable for rendering working 
mode). When entity mode is off, click picks an object 
such as placed element and RPC element (suitable for 
objects animation working mode). 

 

 NOTE   To select an object, make sure that Entity Mode in the Objects toolbar is off. 
Then click on the object you want to select. The object is visually indicated as selected by 
changing its color. 

The transform properties (position, orientation and size) of objects are shown in 
the object properties dialog box, described in the next section. 

Object properties dialog box 

To view the properties of an object, either double-click the object, or right-click 
the mouse and select PROPERTIES, to open the object properties dialog box. 

 

 
 

To view and change the transform properties (position, orientation and size) of 
objects, click TRANSFORM in the object properties dialog box. Here you can view 
and change the translate, rotate and scale values of an object. 
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TRANSLATE Position of the selected object 

ROTATE Orientation of the selected object 

SCALE Scale of the selected object 

DIMENSIONS Size of the selected object 

UNIFORM SCALING When uniform scaling is on, scale is done uniformly 
for all axes. When uniform scaling is off, you can 
scale independently each axis of the object. 

 

When selecting the ANIMATION tab, the animation dialog box is opened. This 
window is inactive when there are no key frames available. 
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This tab displays the total number of frames and keyframes in the object path. To 
choose path type, click the desired radial button. 

PATH TYPE 

SINGLE One single animation course. 

LOOP A continuous animation sequence, beginning at the 
start and then retracing its steps from end to 
beginning and back again. 

REPEAT A sequence that begins at the start and goes through 
to the end and then begins again at the beginning in a 
continuous movement. 

CLOSE Closes the path from the last key frame created to the 
first key frame. 

SMOOTH Smooth the animation path to create motion with 
constant velocity. 

 

When selecting the KEY FRAME tab, the key frame dialog box is opened. This tab 
is available only when object have animation path and key frame is selected. 
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This tab displays the current key frame number, along with the following 
features. 

LINE TYPE Enables you to choose the line type of path for this 
key frame.  Line (default) is a straight path.  Curve 
displays a blue grip and enables you to bend or arch 
the path at this specific point. Break stops the motion 
until it reaches the next key frame. 

TARGET TYPE The target type is not relevant for object path. The 
target is used to define the direction behavior in 
camera and lighting animation. 

CONTROL This feature enables full control over the type of key 
frame used, i.e. what is changed in the key frame: line 
of path, object data or both. Line allows you to 
control only the key frame's position in path; other 
object properties are determined by the previous key 
frame.  Data enables you to determine only object 
properties (e.g. size) but not the position in path. Full 
enables you to control all key frame parameters. 

 

When selecting the STATISTICS tab, the statistics dialog box is opened. 
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This tab displays statistics about the select objects, such as the total number of 
solids, polygons and vertices. 

 

Properties dialog box and current frame 
The properties dialog box shows properties according to the current frame. To 
see all parameters of entity without relationship to animation, view the model in 
basic state (frame is 0 in the animation toolbar). To see parameters of entity in 
specific key frame or frame, view the model in the specific key frame or frame 
(type the frame number in the animation toolbar, or use the animation toolbar to 
go to the specific key frame or frame, or click on the frame number in the frames 
view). For a further explanation about frames, see Chapter 6, Walk-through 
Animation. 

The tabs and fields shown in properties dialog box is according to the current 
frame: 

   
Basic state      Keyframe selected 
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 NOTE   The key frame tab is available only when object have animation path and 
specific key frame or frame is selected. When viewing model in basic state (frame is 0 in 
the animation toolbar) this tab is not available. 

 

Properties dialog box and entity mode 
The entity mode determined which entity is picked when you click on the 3D 
view. When entity mode is on, click picks an entity such as polygon and solid 
(suitable for rendering working mode). When entity mode is off, click picks an 
object such as placed element and RPC element (suitable for objects animation 
working mode).  

The properties dialog box shown is according to the entity type e.g. placed 
element or polygon: 

   
Placed element     Polygon 

 

 NOTE   To select an object (i.e. placed element), make sure that Entity Mode in the 
Objects toolbar is off. Then click on the object you want to select. The object is visually 
indicated as selected by changing its color. 
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PhotoPhotoPhotoPhoto----realistic Objectsrealistic Objectsrealistic Objectsrealistic Objects    

 
This chapter explains how to insert photo-realistic objects into your scene using 
ARC+ Render Pro commands. 

Photo-realistic objects, such as people, trees and automobiles, are supported by 
RPC plug-in. With RPC plug-in, you can place and edit RPC objects that are 
dynamically replaced at render-time with the image that is appropriate for the 
current viewing direction. RPC technology provides new level of photo-realism, 
with significantly improved rendering time, in remarkably simple user interface 
as easy as drag and drop. 

 

 

What is Photo-realistic Object 
Photo-realistic objects are rendered using image-based rendering technology. 
RPC is the first major commercial project in the evolution of image-based 
rendering technology. Rather than rely upon complex geometry to represent 
objects in 3D, RPC technology utilizes image data, and is capable of reflecting an 
incredible richness of detail. The use of continuously updated and synthesized 
image data creates a stunningly effective 3D illusion. 

10



Photo-realistic Objects   

10-2  ARC+ Render Pro User's Guide 

 

A simple representation is used to orient your 
RPC content within the geometry of your 
scene. At render time the RPC Plug-in 
calculates the viewing angle of the RPC object 
relative to the virtual camera. The appropriate 
corresponding images are then synthesized, 
creating the illusion that a complete 3D object 
exists in the scene. 

 

 

Working with Photo-realistic Objects 
Photo-realistic objects are available in the Models library bar. The Library stores 
RPC photo-realistic objects, which can be easily inserted into your scene. 
Commercial RPC plug-in is required to support commercial RPC content. Demo 
RPC content can be used without RPC plug-in license. 
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To insert a photo-realistic object, select it from the relevant library bar, and drag 
and drop it into your scene.  

 NOTE   To render RPC element correctly, select drawing mode that support 
transparency mapping, such as ray tracing. 
 

To delete an existing photo-realistic object, select the object you want to delete, 
and press the delete button on your keyboard, or click Delete on the Edit menu. 

 NOTE   To select a photo-realistic object, make sure that Entity Mode in the Objects 
toolbar is off. Then click on the object you want to select. The object is visually indicated 
as selected by changing its color.  
 

 

To view properties of RPC element, either double-click on it or right-click the 
mouse and select PROPERTIES, then click RPC. 

 
 

Some RPC objects provide additional editable parameters (for example: steering 
of wheels of automobile RPC object). To edit RPC parameters, click EDIT. 

To change the units of a RPC element, click UNITS, and select the appropriate 
units. Default units for RCP objects are inches. 
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Photo-realistic objects can be manipulated and animated as other objects. For 
further information about working with objects, see Working with objects in 
chapter 9, Objects Animation. 
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